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1. Plane Modeling

This section explains how to model equipment and frameworks by connecting planes that are
automatically extracted by the Extract Planes and Pipes function/command.

Preparing for plane modeling

« If planes are not yet extracted, run [Extract Planes and Pipes] first. Refer to "Extracting
Planes and Pipes" in "InfiPoints Operation Manual Vol.1. Data Pre-processing" for

details.
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* Select [Home] tab > [Display Status] > [Show/Hide Planes] ( /) to display the

extracted planes.
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View Operation

o When selecting [Show/Hide Planes], you can toggle between [Show
Planes] ( /7 ) and [Hide Planes] ( £ /).

 Select [Modeling] tab > [Start Modeling Plane Elements] from the Ribbon menu.
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[Plane] tab appears. Users can perform plane modeling using functions in this tab.
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About the display area of the 3D View Window

» Limiting the display area by using the Clipping Box function can be useful when
modeling an equipment partially. A Clipping Box can be created/edited with the
[Create Clipping Box] (|/-! ) and the [Edit Box Section] (|<¥*|) functions from the
[Clipping] panel.

Changing/Fixing the rotating center of the 3D View Window

 Fixing the rotating center also can help change the viewpoint readily/smoothly. Set the
rotating center with the [Fix (Fix at Selected Element)] function/command on the
upper right side of the 3D View Window.

~ | Fix (Fix at Selected Element)
Auto (Auto-set Rotation Center)

Viewpoint (Set at Viewpoint)
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1.1. Creating Rough Models

This chapter explains the procedure to create a rough 3D model automatically from point cloud
data with scan index.

1.1.1. Auto-creating Rough Models

1. Select [Plane] tab > [Create] > [Create Rough Model] ( @ ).

-l AR ¢ Smart Filter o ?InfiPoinis Modeling Tool

Home Import Pre-process Analysis Maodeling Qutput Creation Recent Help I[ Plane I
° | e, | @ e
W | 9 2 G DY K M 0O wogs
1) 7 23

Extract Planes Create Create Create Create Deted Extrude Edit Flip Connect Disconnect Extend Merge Move Copy
and Pipes Rough Modell| Plane Block Cube Object Plane Boundary = Plane = W =

Extract Primitive | Create | Edit

2. Select a point cloud group with scan index to create a rough 3D model from in [Tree
(Overview)] panel.

Overview Pipe Plane Structure Duct

=18 Model
5 Scans

2| Groupt
s LSOT364_020

i L507364 021

& LS07364_022

% LS07364_023

% LS07364_024

é; LS07364_025

% LS07364_026

7% LS07364_027

[s7 Extracted Planes

-] a Extracted Piping System

This requires the point cloud data with scan index. Please ensure that the
point cloud with scan index in the selected group is set to shown in [Tree
(Overview)] panel.

Overview Pipe Plane Structure Duct
=718 Model

-3 Scans
0 =847 Groupl

IoEs

LS07364_021
LS07364_022
LS07364 023
LS07364 024
LS07364_025
| LS07364 026
| Lso7364 027

[ ]l Extracted Piping System

3. "Create Rough Model" dialog will appear. Move the slider based on the target space size, and
click [OK]. A rough model creation will start.
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Create Rough Model

Smaller area of Larger area of
approx. 1-2 approx. 5-6
room(s) rooms

o[ e

4. The following dialog will appear upon the completion of a rough model creation. Click [OK].

Create Rough Model X

The process has been completed.

InfiPoints

Use [Plane] tab = [Simplify]/[Delete Planes)/[Connect Planes] to
edit the created rough madel manually.

The rough model will be added to [Tree (Plane)] panel as "Plane Group".
(Right: Only the rough model is shown in "3D View" window.)

Overview Pipe Plane  Structure Duct

=-bAE) Extracted Planes
EI Auto-extracted Plane Groups
© a7 0.0001-0.01 m2: 1

7 0.01-0.04 m2:2

i 0.4 -016m2: 3

i 0.16-1m2: 4

[ 1-100m2: 5

E|?1 Plane Group: 6

1.1.2. Editing Rough Models

This section explains the procedure to edit the rough 3D models created with [Create Rough

Model] as required using following commands.

+ [Simplify] ()
« [Delete Planes] (4%)
e [Connect Planes] (|]J)
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InfiPoints *

Use [Plane] tab > [Simplify]/[Delete Planes]/[Connect Planes] to
edit the created rough model manually.

This section explains the procedure to edit the rough model with [Simplify] ( @ as an example.

1. Select [Plane] tab > [Simplify] ( #7).

Modeling Toal — O X

Help Il Plane--]l
LGS ZT @ | W g

Copy Mowve Createf Simplify Plane Group Planes within | Align Plane  Align All Close
¥ Parallel Hole Clipping Bax / Section Group  Plane Groups | this Tab
Delete | Group | Align Exit

2. Select planes around the unnecessary details to remove in "3D View" window, and click

[Donel (@)

3. Select a plane that consists of the unnecessary details to remove in "3D View" window.

The unnecessary details surrounded by the selected planes will be removed.
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>

m Other Examples of Editing Rough Models

>

>

The following error message may appear when filling a hole on a plane with

[Simplify] (7).

InfiPoints

Please ensure to select plane(s} which have hole(s) to fill,
! and/or unnecessary details (convex shape} composed with
planes to remove,

The plane(s) to remove are possibly connected to the plane(s) which do not
consist of the target rough model. In such case, delete those plane(s), and try
again.
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1.2. Creating Planes

1.2.1. Creating Planes

1. Select [Plane] tab > [Create Plane] ( £ ).

) - | Smart Filter *  FInfiPoints Modeling Tool
Home Impart Pre-process Analysis Madeling Cutput Creation Recent HeIpI Plane I

oa 7 1 - B B i BiMerge 1 Move Parall¢
ity oy K GO I M
= = b = Move ~ i Create Hole
Extract Planes Create Create §iT®ate Create Deted Bdrude Edit Flip  Connect Disconnect Extend e
and Pipes Rough Modelfl Plane 8 Block Cube Object Plane = Boundary~ Plane - + Copy ~ & Simplify
Extract Primitive Create Edit

2. In [Option] panel, specify how to create a plane. In this case, select "By selecting 2 semi-
perpendicular planes (perpendicular to them)".

Option B

ﬂﬂ Options

Specify how to create a plane
(O By selecting 3 points

0.01

I (®) By selecting 2 semi-perpendicular planes (perpendicular to them) I

3. Select the first plane in "3D View" window. The plane that will be created can be previewed
while selecting the second plane and moving the cursor over it.

4. Select the second plane, and a new plane will be created.
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Create with "By selecting 3 points" option when the points for the object to
create a plane are available.

Option
Q ﬁﬂ Options

Specify how to create a plane

I (®) By selecting 3 points I

Existing error m

5. Click [Cancel the selection and quit this function] ( Q ) or press [Esc] key to exit the
command.

1.2.2. Creating Blocks(Solid)

1. Select [Plane] tab > [Create Block] ( {7 ).

Ay (% % | < |Smart Filter *  FinfiPoints Madeling Tool
Home Import Pre-process Analysis Modeling Qutput Creation Recent Help m

el /| * 7 h g 99
0 | & & K &Gm I Qw:es
Extract Planes Create Create] Create | Create Detect Bxtrude Edit Flip Connect Disconnect Extend Merge Move
and Pipes Rough Model Plane ) Block §| Cube Object Plane EBoundary ~ FPlane ¥ v
Extract Primitive Create Edit

2. Select "Complement planes” > "Complement" option in [Option] panel.

Complement planes

(®) Complement

() Don't complement

@ &

Complement  Don't complement

0 "Complement" option is to create a six-sided block for the objects which
planes are not extracted for all sides.
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Q Select "Don’t complement" option to create a sheet model ("), e.g., a plane
with free edge(s).

3. Select two or more planes to form a block, and click [Done] ( 0 ).
Six planes to form a block will be created at where the selected planes are.

\ SV

O The result solid model without free edges will be added to [Tree (Plane)]
panel as "Plane Group ' ".

4. Click [Cancel the selection and quit this function] ( m ) or press [Esc] key to exit the
command.

1.2.3. Creating Cubes

1. Select [Plane] tab > [Create Cube] ( @ ).

LN |_jT!5mart Filter * | FInfiPoints Modeling Tool
Home Import Pre-process Analysis Modeling Cutput Creation Recent Help m

o -Li.:] _/;6 @. /T - Vo = P 2 DG
oLl a Ll 3] L :
Y 4P KG a W X & J e
Extract Planes Create Create Create| Create JDetect Extrude Edit Flip Connect Disconnect Extend Merge Move

and Pipes Rough Model Plane Block | Cube §Object Plane Boundary = Plane ¥
Extract Primitive Create Edit

2. In the 3D View Window, select the plane at the position where you would like to create a
cube. A cube will be created based on the size of the selected plane.

Q If you would like to change the size of the cube you created, you can do so
by moving each plane using [Move Parallel] ( ﬁ_ﬂ ).
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1.2.4. Extruding Planes

1. Select [Plane] tab > [Extrude Plane] ( w ).

| AN x | Smart Filter = IFIm‘iPoints Modeling Toal
Home Import Pre-process Analysis Modeling Cutput Creation Recent Help W
- I P =
) & 2 G @ Gl LK I il O
— =y \lflj ( =
Extract Planes Create Create Create Create DetectfExtrude Edit Flip Connect Disconnect Extend Merge Move
and Pipes Rough Model Plane Block Cube Object§ Plane Boundary = Plane v v

Extract Primitive Create Edit

2. Select a plane to extrude in "3D View" window.

3. "Extrude Plane" dialog will appear. Select "Extrude to a specified point or a plane" option,
and click [Edit].

Extrude Plane x
(") Extrude by the specified value 0 m
(®) Extrude to a spedified point or a plane
() Extrude to any location Edit
Cancel

4. Pick a plane to extrude to, and a preview of the extruded shape will be displayed on "3D
View" window.
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Note that side planes may get divided into multiple parts when extruding
complicated planes. Simplify the shape of the plane first by using [Edit
Plane Boundary] ( [;( ) to avoid this.

o Extrusion without editing the plane

o Extrusion after editing the plane

6. Click [Cancel the selection and quit this function] ( @ ) or press [Esc] key to exit the
command.
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1.3. Editing Planes

1.3.1. Editing Plane Boundaries

1. Select [Plane] tab > [Edit Boundary] > [Entire Boundary] ( <% ).

A 2 ||Smart Filter ~ | FInfiPoints Maodeling Tool
Home Import Pre-process Analysis Modeling Qutput Creation Recent Help m

o = /J" & £ o 7 - i b i . 28
A= ﬁj- £E *\Cj l—%.‘. r_lf.rﬁ w —l L S | [l U
Extract Planes Create Create Create Create Detect Extrude Flip Connect Disconnect Extend Merge Move
and Pipes Rough Madel Plane Block Cube Object Plane Boundary ~_JPlane k4 9
Extract Primitive Create % Entire Boundary
Tree L | %, Part of Boundary
Ovenview Pipe Plane Structure Duct S, Trim Plane
:—;--E Model % Divide Plane
-5 Scans

2. [Option] panel will appear. Specify whether to align the result boundary, and check "Change
to Section view while drawing lines" option.

Option
ﬁﬂ Option

Align the plane boundary
(®) Perpendicular or horizontal to Z-axis
() Perpendicular to the edge of selected plane

) Don't align

Change to Section view while drawing lines

3. Select a plane which is not connected to any other planes.

Q To edit the boundary of a plane which is connected to other planes,
disconnect it with [Disconnect] ( 2 ) beforehand.

4. "3D View" window will switch to Section Mode. Draw a new boundary line by clicking at
breakpoints in "3D View" window.
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5. Click at the start point to close the boundary, and the plane boundary will be updated.

6. Click [Cancel the selection and quit this function] ( Q ) or press [Esc] key to exit the

l

command.
o,
1.3.2. Editing a Part of Plane Boundary
1. Select [Plane] tab > [Part of Boundary] ( <% ).
e s | smart Fiter +  EiInfiPoints Madeling Tool
Home Import Pre-process Analysis Modeling Output Creation Recent Help m
oa o & M L > v W 98
— ml 4y NP l—@-l- r_-:ﬂ [ L. | l] | =S
Extract Planes Create Create Create Create Detect Extrfjde Flip Connect Disconnect Extend Merge Maove
and Pipes Rough Model Plane Block Cube Object Plafje Bg ry ~ BPlane d =
Extract Primitive Create % Entire Boundary Edit
s o
Overiew Pipe Plane Structure Duct %, Trim Plane
=] E Model %, Divide Plane
=043 Scans

2. [Option] panel will appear. Specify whether to align the result boundary, and check "Change

to Section view while drawing lines" option.

Page 14 | 145
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Option % |

ﬂﬂ' Option

Align the plane boundary
(®) Perpendicular or horizontal to Z-axis
() Perpendicular to the edge of selected plane

) Don't align

Change to Section view while drawing lines

3. Select a plane which is not connected to any other planes.

4. "3D View" window will switch to Section Mode. Select line segment(s) to edit in "3D View"
window.

Q Select the start point and the endpoint, and the line segments in between
will be auto-selected.

5. Selected line segments will be highlighted in light blue.
Confirm that the target is selected as intended, and click [Done] ( 0 ).
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g Boundaries which are not connected to already-picked one are not
pickable.

6. Draw a new boundary line by clicking at breakpoints in "3D View" window. Start at either of
the blue circles.

0 The start point and the endpoint are marked with blue circles. Please
ensure to start/end the boundary line at the blue circles.

7. Click at the other blue circle, and the plane boundary will be updated.

8. Click [Cancel the selection and quit this function] ( Q ) or press [Esc] key to exit the
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command.

1.3.3. Connecting Planes (by Selecting a Plane)

1. Select [Plane] tab > [Connect] > [Connect Planes] ( | l_ ).

L '.'-!SmartFiItEr - FInfiPoints Madeling Tool
Home Import Pre-process Analysis Modeling Cutput Creation Recent Help

Ryl & - oA o 94
Y | ) RGAR[Y| K LM w3
Extract Planes Create Create Create Create Detect Extrude Edit lip §|Connect Disconnect Extend Merge Move

and Pipes Rough Model Plane Block Cube Object Plane Boundary ~ ane| = =
Extract Primitive Create 1

Connect Planes

Tree Connect Plane Groups

Overview Pipe Plane Structure Duct
=8 Model
=257 Seans

Compose Wall

| Compose Cbject

2. Select two planes to connect in "3D View" window, and click [Done] ( 0 ).
Selected planes will be extended and connected to each other.

ViV

Select three planes to connect the selected three planes.

> You cannot connect planes if the orientations are not aligned. You can
ﬂ flip the orientations of planes with [Reverse Planes] ( ‘. ).

> You cannot use this functionality when neighboring planes do not exist.
In such a case, create a plane first.

3. Click [Cancel the selection and quit this function] ( 9 ) or press [Esc] key to exit the
command.

1.3.4. Connecting Planes (by Selecting Plane Group)
You can create a solid model by extending the surfaces of equipment toward walls and floors.

1. Select [Plane] tab > [Connect] > [Connect Plane Groups] ( ).
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Modeling Tool

) © |smart Filter ~|  #InfiPoints
Home Import Pre-process Analysis Modeling Output Creation Recent Help

oa M i & p= - 3 &F T ~ =
— 4'{ ﬁ% N I—E’I-l- (_:’@ X ‘l ey | S
Extract Planes Create Create Create Create Detect Extrude Edit lip §|Connect Pisconnect Extend Merge Move
and Pipes Rough Model Plane Block Cube Object Plane Boundary ~ ane = =
Extract Primitive Create I Connect Planes
Tree L8 x| W Connect Plane Groups
Ovenview Pipe Plane Structure Duct Compose Wall
=& Model | Compose Object
e-Eg Scans

2. In the 3D View Window, select a Plane Group from equipment first, and then a Plane Group

from a framework.

>

3. "Connect 2 Plane Groups" dialog will appear. Select "Create a solid (for equipment)" option,

and click [OK].

Connect 2 Plane Groups

Specify how the result should be.

(®) Create a solid for equipment)

() Cut intersections and connect for building frame)

() Extend only {Plane groups will not be

connected)
Cancel

A solid model will be created from the Plane Groups.
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If you cannot select Plane Groups or fail to extend selected Plane Groups,

0 make sure there are no unconnected thick edges left except for ones
parallel to walls and floors. If there are any left, connect those first using
the [Connect Planes] > [By 2 or 3 Planes] ( L) option.

1.3.5. Connecting Planes (by Composing Wall)
Create a new plane group by connecting the planes at the wall, floor, and ceiling positions.

1. Select [Plane] tab > [Connect] > [Compose Wall] ( % ).

FE i) - |Smart Filter + | FInfiPoints Madeling Tool
Home Import Pre-process Analysis Modeling Output Creation Recent Help
) F F=) / LT “ r: I = a l-\ [l L A&
‘ a7 Z (0 ] d v ;
e =/ X i L‘?xl-i- :E w \ v A | 4 ‘ U ey
Extract Planes Create Create Create Create Detect Extrude Edit lip §|Connect Disconnect Extend Merge Move
and Pipes Rough Model Plane Block Cube Object Plane Boundary~ Hfane = i
Extract Primitive Create I cConnec Planes
Tree L3 * | W Connect Plane Groups
Overview Pipe  Plane Structure Duct ® Compose Wall
:—,--E Model X Compose Object
=23 Scans

2. On "3D View" window, pick the planes positioned to surround an area(walls) in sequential
order. After picking all the planes you want to connect, press [Done] ( 0 ).

0 Please note that the planes should be selected in the order you want to
connect them. Select a plane to preview it on "3D View" window.

3. When connecting the floor and the ceiling, select the planes in the order of floor, then
ceiling, and press [Done] ( o ).
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Please note that specifying the floor and the ceiling are optional. If you
0 press [Done] ( o ) without specifying the floor or the ceiling, only the

walls are created.

The new plane group is created.

Please note that the planes connected by the function [Compose Wall]

( ™ ) will be named floor, ceiling, and wall, respectively.

Tree

Overview Pipe

Plane Structure Duct

=-f715) Extracted Planes

0 +j I ] Auto-extracted Plane Groups
Plane Group: &

" Floor: 3183

- Wall:

- Wall:

- Wall:

-~ Wall:

- Wall:

- Wall:

KHERKR-RE

3182
3180
mz
3156
3173
2052
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1.3.6. Merging Planes
1. Select [Plane] tab > [Merge] ( [} ).

A 0% 3 | |smart Filter © FInfiPoints Madeling Tool
Home Impaort Pre-process Analysis Modeling Qutput Creation Recent Help

W 49 2GR Q[EP X N B hw

7
Extract Planes Create Create Create Create Detect Extrude Edit Flip Connect Disconnect Extend) Merge | Move Copy
and Pipes Rough Model Plane Block Cube Object Plane | Boundary~ Flane = e ¥

Extract Primitive Create Edit

2. Select planes to merge in "3D View" window, and click [Done] ( 0 ). Selected planes will be
merged into a single plane.

>

Q You can select multiple planes by using the [Area Selection Mode] ( 0y, or
by dragging planes while holding down [Ctr]] key.

3. Click [Cancel the selection and quit this function] ( Q ) or press [Esc] key to exit the
command.
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1.4. Copying/Moving Planes

1.4.1. Copying Planes

1. Select [Plane] tab > [Copy Plane] ( 4. ).

Modeling Tool
g Cutput Creation Recent Help Plane
£ . p b ‘I] [ L‘l |9 a ﬁ- .
ﬁ‘( 7 4 J\ .E;) L ] @ v %
Edit Flip Connect Disconnect Bxtend Merge Move | Copy ‘ Move Create Simplify Plane
Boundary* FPlane - b bl ara_llel Hole
Edit I - Copy Plane I

Copy Plane Group

2. Select a plane to copy in "3D View" window. A guide will appear for the selected plane.

Va s

"Select an "Extracted Planes" to copy to" option will be displayed in [Option]
panel when there are multiple sets of "Extracted Planes" in [Tree
(Overview)] panel. Check this option to specify the "Extracted Planes" to

Q copy to.

z [0 |

I Select an "Extracted Planes™ to copy to I

3. Move the cursor along the guide, and left-click to fix the position.

.
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ﬂ The guide axes correspond to the XYZ direction of the current coordinate
system.

You can also move by specifying the values in [Option] panel.

Option
aﬂ Option

Q Distance

4. To continue copying another plane, click [Done] ( 0 ).
Click [Cancel the selection and quit this function] ( @ ) or press [Esc] key to exit the
command.

Q The direction of the copied plane can be aligned with other planes by
selecting [Edit] > [Flip Plane] ( ‘< ).

1.4.2. Copying Plane Groups

1. Select [Plane] tab > [Copy Plane Group] ( . ).

Modeling Tool

g CQutput Creation Recent Help Plane
[ Y [ - |- = AT
Edit Flip Connect Disconnect Extend Merge Mowvel Copy (Mo Create Simplify Plane
Boundary~ Plane < 2 = arallzl Hole
Edit - Co;le
Coov All Plane Groups to Another Ext

2. Select plane group(s) to copy in "3D View" window, and click [Done] ( 0 ).
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3. The guide will appear for the selected plane group(s) at the last-clicked location.
Move a copy along the guide axes, and left-click to place the copy.

VA

4. Click [Done] ( Q ) to continue copying plane groups.
Click [Cancel the selection and quit this function] ( @ ) or press [Esc] key to exit the
command.

VA
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1.4.3. Moving Planes Parallel

1. Select [Plane] tab > [Move Parallel] ( I'_i_f' ).

Modeling Tool

g Cutput Creation Recent Help Plane

= F 1 Pl [ P }7,
K <y W Lﬁ, LN o
Edit Flip Connect Disconnect Extend Merge Move Copyfl Move [Create Simplify
Boundary~ Plane - - - Parallel | Haole

Edit

2. Select a plane to move in "3D View" window. "Move Plane" dialog will appear.

3. Select "Move to specified point or plane" option, and click [Edit].

Move Plane X
() Move plane the specified value 0
(®) Move to the spedfied paint or plane Edit
(C) Move to any location Edit
Cancel

4. Select a plane in "3D View" window to specify the destination. A result preview will be
shown in "3D View" window.

5. Click [OK] in "Move Plane" dialog if the result looks good, and the plane will be moved to the
specified location.
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1.4.4. Moving Plane Groups

=

1. Select [Plane] tab > [Move Plane Group] ( [1}').

Maodeling Tool
Ii] Cutput Creation Recent Help Plane
. r e e - - =y . i
&K & N mlzg e - @
( L 4 J-.. ~[-. L ] - e —UL'.j [ ';“‘
Edit Flip Connect Disconnect Extend Mergel| Move BCopy | Move Create Simplify
Boundary = Plane - b h arallel Hole
Edit e Move Plane Group

~ Move All Plane Groups

2. Select plane group(s) to move in "3D View" window. The handles will appear for the selected
plane group(s).

' It is not possible to select only a part of the planes from a plane group.

3. Drag the handles to move the selected plane group(s).
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You can also move by specifying the values in [Move] panel. Please refer to
[Move] in Elysium InfiPoints Operation Manual Vol.2. Point Cloud
Utilization - Simulation & Data Utilization for the operation in [Move]
panel.

Q Farallel move Rotation maove

® Relative () Absolute World coordinate system
Translate distance X|U |M ¥ |U |U‘ Z|U |U‘ 2 (m)

Pitch 0.1 = (m)

Orientation: @) Rotation axis O XY(Top) O YZ(Right} O xZ(Front) O Section

No Snap Move Restore Clear

4. Click [Cancel the selection and quit this function] ( Q ) to finalize the move and exit the
command.
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1.5. Deleting Planes

[Extract planes and pipes] will automatically extract detailed planes and pipes from point cloud
data. You can remove unnecessary planes and pipes with the filtering functionality before
exporting the data to other software packages in order to increase efficiency of post-processes.

1.5.1. Deleting Planes

1. Select [Plane] tab > [Delete] > [Plane] ( 3( ).

Modeling Tool

Cutput Creation Recent Help Plane

/1< A7 [l r i I -l‘ 2@ [2 ' Move Parallel % Plane Group
\ﬁ J - |_[| — ToTeare HUIE} é*

*. Excass Plane

Edit Flip Connect Disconnect Extend Merge MWove Copy . . Flane
Boundary = Plane < - - & Simplify

Edit Delete

2. Select the plane you would like to delete in the 3D View Window. The selected plane will be

v

Q If you want to delete the entire plane group, use [Plane Group] ( ';( )
instead of [Plane].

3. Click [Cancel the selection and quit this function] ( Q ) or press [Esc] key to exit the
command.

1.5.2. Deleting Unnecessary Planes Collectively

1. Select [Plane] tab > [Delete] > [Excess Plane] ( x ).

Modeling Tool
QOutput Creation Recent Help Flane
e A7 [ila - Ml 94 1] Move Parallel % Plane Group
KR &N I A 28 E -
s st
Edit Flip Connect Disconnect Extend Merge Move Copy = ) Plane
Boundary~ Plane - - + [ Simplify
Edit Delete

2. Specify [Minimum area of plane] in the "Delete Over-extracted Planer Elements" dialog.
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Delete Excess Plane >

Minimum area of plane m2
0.447214 | m per side{corresponding)

Cancel

0 You can change the value with the slide bar.

The planes to be deleted are highlighted in red in the 3D View Window.
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1.6. Aligning Planes

This function will align planes within a Plane Group in parallel or perpendicular to each other.

1.6.1. Aligning the entire planes within a plane group

1. Select [Plane] tab > [Align] > [Align All Plane Groups] ( “%7 ).

Modeling Tool
it Creation Recent Help Plane
Fi - r

ﬁE - % Plane Group [ | '_|/'.,. ;

e «E_-’ & % ! H 7 B3
Move Create Simplify Plane Group Planes within | Align Planel Align All Close
Parallel Hole Clipping Box / Section Group JPlane Groupsl this Tab

Delete Group Align Exit

2. "Align Plane Group" dialog will appear. Set the angle tolerance and the alignment options
and click [OK].

Align Plane Group *

Angle tolerance I:| degree(s)

[Jalign to horizontal or vertical direction

Also align vertical planes to X or ¥ axis

Cance

When the [Align to horizontal or vertical direction] option is enabled,
alignment will be adjusted parallel/perpendicular to the Z-axis of the world
coordinate system.

All the planes in the plane groups will be aligned based on the criteria specified in the
dialog.

Align Plane Group

Successfully aligned @ plane groupis).
Red: Planes / Aligned Green: Planes / Not aligned

0 Planes automatically extracted by [Extract planes and pipes] are not subject to
alignment.
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Q Use [Align Plane Group] ( | | ) if you would like to align only the ones you
select.

1.7. Editing the Tree Structure of Planes

The configuration of planes can be checked on the [Tree (Plane)] panel. This can be useful in
cases such as:

» To group multiple pieces of equipment together.
* To classify plane groups by category (framework, equipment, etc.).

» To switch show/hide status with a single-click when exporting CAD format files.

1.7.1. Checking Planes with the [Tree (Plane)] Panel

* You can check the configuration of planes/plane groups in the model with the [Tree (Plane)]
panel.

Tree % |

Crverviem  Pipe I Flane IStructure Dt

=54 £ Extracted Planes
EID Auto-extracted Plane Groups
[ 00001 -00Tm2: 1
00T -00dm2: 2
L 00d-016m2: 2
L o1e-1m2:4
L0 1-100m2: 5
m- " Plane Group: &
m-M 7 Plane Group: 7
E-BA (7 Plane Group : &

* By selecting planes/plane groups in the tree, corresponding planes/plane groups in the 3D
View Window will be highlighted.

o When a plane group is selected on [Tree (Plane)] panel

Tree

Owerview Pipe  Plane  Structure  Duct
B--E Extracted Planes
123 Auto-extracted Plane Groups
J0.0001 - 00T m2: 1
0 001-004m2: 2
0 004-076m2: 3
D 0ie-1m2: 4
J1-100m2: 5
1! Plane Group: 6
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Conversely, by selecting a plane or plane group in the 3D View Window, corresponding
planes/plane groups in the tree will be highlighted.

o When a plane is selected on "3D View" window

Tree

Owerview Pipe  Plane  Structure  Duct

B Plane Group: 14
( Plane Group: 15
( Plane Group: 16
5.[A) Plane Group: 17
LA Plane: 304
. 7 P H 40
A= Plane: 2247
[A= Plane: 2248
[A= Plane: 3242

o Switching the pick filter to either [plane] or [plane group] may help
make selection easier.

=
4y Piping ElementIle #InfiPoints -

Home Impofy Smart Filter tput ¢

Q b .-_-_l Piping Element / Plane / Duct Element

Extract Planes Create
and Pipes Plane Block Cube Object Plane EBoundary Plane =

Fiping Group / Plane Group / Duct Group

> You can select multiple planes by pressing down the [Shift] or [Ctrl]
keys while making the selection.

» To view the point cloud around the selected plane, right-click on a plane element or a plane
group in [Tree (Plane)] panel, and select [Fit View to Element size] or [Display Surroundings

Only] from the context menu.

Tree x |
Overview Pipe  Plane  Structure  Duct
=1-54 =] Extracted Planes
D Auto-extracted Plane Groups
-',/ Plane Group: &
:’ Plane Group: 7

-

" @ Fit View to Element size
M Display Surrcundings Only

Delete

* Right-click on an element in [Tree (Plane)] panel, and select "Collapse All Plane Groups"
from the context menu to close the entire plane groups.
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Owverviem  Pipe Plane  Structure Duct

Cwerviem  Pipe Flane Structure Duct

E--Eﬁ Extracted Planes ~ E--@E Extracted Planes ~
B Group Plane Groups =[] Auto-extracted Plane Groups
. Highlight Group Names in Display Col I 00001 - 001 m2: 1
ghlight Group Names in Display Coler P 0.01- 0.04m2: 2
_clenncon G0 aa-arome
—e L 06 - 1 mzs4
L 1-100m2: s L 1-100m2: 5
=17 Plane Group: & -1 Plane Group: 6
J~] = Floor: 2183 @-b(7 Plane Group: 7
[l Wall: 3178 =-(7 Plane Group: 8
[l Wall : 3095 -0 Plane Group: 9
e Wall s 3182 @-b(7 Plane Group: 10
-.[r] = Wall: 3180 =-( Plane Group: 11
e Wall 31T m-B( Plane Group: 12
o Wall: 3156 @-b(7 Plane Group: 13
=8¢ Plane Group: 7 w-I( Plane Group: 14
[l Plane: 3184 @-B( Plane Group: 15
J~] Plane: 3185 @-b(7 Plane Group: 16
-.[#l# Plane: 3186 W w-B7 Plane Group: 17 W
< > <

* In the [Property] panel, you can check the properties of a plane, such as the coordinates of a
vertex and the normal direction.

[ Coordinate system (World coordinate system) 1
Plane Group [6

Mumber of Planes: 7

Twpe: Sheet

Surface frea: 2337400 m2

1.7.2. Creating Plane Groups

1. Right-click on "Extracted Planes" in the [Tree (Plane)] panel and select [Group Plane Groups]

to create a Plane Group.

Overview Pipe  Plane  Structure  Duct

Overview Pipe  Flane

Structure

Duct

(=) iExtracted Planes;

L GroupPlaneGroups

E 17 Plane Group: 7
i-p7] (7 Plane Group: 8

=i 5] Extracted Planes
aLkAlCa Auto-eutracted Plane G pUPS

[AC3 Grouped Plane Groups
A7 Plane Group: 6
&b (7 Plane Group: 7

2. Drag and drop plane groups to move them to different groups.
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Overview Pipe  Plane  Structure  Duct

=1-54 =) Extracted Planes
#-[](7] Auto-extracted Plane Groups

- Grouped Plane Groups
E[ﬂ' Plane Group: 6
AP Plane Group: 7
{7 Plane Group: 8
Eﬁp Plane Group: 10
E@' Plane Group: 11

You can also further divide plane groups into smaller subgroups.

Owerview Pipe  Plane  Structure  Duct

=-[+] 5] Extracted Planes
-3 Auto-extracted Plane Groups
v og

Grouped Plane Groups

Grouped Plane Groups
: Eﬁ?—' Plane Group: &

; Plane Group: 7
T Plane Group : &

E@' Plane Group: 10

&-F P Plane Group: 11

1.7.3. Renaming Plane/Plane Groups

You can rename plane groups and planes by right-clicking on a plane or a plane group in the
[Tree (Plane)] panel and select [Rename].

Overview Pipe  Plane  Structure  Duct Overview Pipe  Plane  Structure  Duct
=443 Extracted Planes =-}] &) Extracted Planes
@ Auto-extracted Plane Groups @ Auto-extracted Plane Groups

EE hanical system
=23 Grouped Plane Groups
- Plane Group: 6

: @ﬁp Plane Group: 7
@ i Delete -bA () Plane Group: 8

- iz - Plane Group: 10

ST ename B Plane o 1

* You can also rename plane groups or planes by pressing [F2] while
Q selecting a plane or a plane group in the [Tree (Plane)] panel.

Fit View to Element size ’

Display Surrcundings Only

-

* Delete the name using the [Backspace] key to restore the default name.
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1.7.4. Switching Show/Hide Status of Planes

In the [Tree (Plane)] panel, check/uncheck the check box to show/hide items inside the tree

view.

Owerview  Pipe  Plame  Structure  Duct

=- EE Extracted Planes

@é—" Plane Group: &
- (7 Plane Group: 7
AP Plane Group: &
E-B 7 Plane Group: 10
B Plane Group: 11

Owerview Pipe  Plane  Structure  Duct

E--EE Extracted Planes

E| @D Mechanical system

. o
i IEL‘T‘ Plane Group: 10
E-p1 (7 Plane Group: 11

i 103 Auto-extracted Plane Groups

* Checking/unchecking the check box of a plane will show/hide all of the
planes that are part of the same group plane.

Overview  Pipe  Plane  Structure  Duct

E--@E Extracted Planes ~

@D Auto-extracted Plane Groups
= ED Mechanical system

EI (22 Grouped Plane Groups

H E| 7 Plape Groun 6
: I Plane : 358
: Dﬁ‘ Plane Group: 7

l@@ PIaneGruup & y

I e T Y

i

* If you would like to show/hide individual planes, check/uncheck "Extracted
Planes" on [Tree (Overview)] panel.

Owerview Pipe  Plane Structure  Duct

..... @@ Duct S}rstem
----- EEI Created_Duct_Group
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1.7.5. Changing the Display Color of Planes

1. Right-click on a plane or plane group in the [Tree (Plane)] panel and select [Edit Display
Color] to change the display color of the [Tree (Plane)] panel.

Overviem Pipe Plane  Structure Duct
=1-[_1E] Extracted Planes
[:| Auto-extracted Plane Groups
E| .D Mechanical syslem
: =B (58] Grouped P D
: w-b P Pl Fit View to Element size

w-bA ( Plc Display Surroundings Only
.u‘”‘ Plane

: . Delete
-.L‘f‘ Plane Gro Move

Rename

Group Plane Groups

Edit Display Color..

2. "Color" dialog will appear. Select any color you prefer and click [OK].

Pt

Color

Basic colors:

ERNENT
EEENTT
ERENTT
ERNENT
THREET

Custom colors:

| Cefine Custom Colors = |

| [a] || Cancel |

The selected color will be reflected in the tree view.

Cwerview  Pipe  Plane  Structure  Duct

=-[ 150 Extracted Planes
- A Auto-extracted Plane Groups
B D Mechanical sg,rstem

i ..L:F] F'IaneGru:l-up 10
..L:F1 Plane Group: 11
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-b-

To clear the selected color, right-click on the plane or plane group and
choose [Reset to Default Color].

Owerview Pipe  Plane  Structure  Duct

B--DE Extracted Planes
-b(1] Auto-extracted Plane Groups
-3 Mechanical system

GRS

ComE Fit View to Element size
-0 [ Display Surrcundings Only

(7 Plane

i i Plane € Delete
m-M 7 Plane Grou Move

Rename

Group Plane Groups

| Edit Display Color...
Reset to Default Color
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2. Pipe Modeling

You can easily add, remove and edit pipes using the automatically extracted pipes by "Extract

Planes and Pipes."

Preparing for Pipe Modeling

» If the pipes are not extracted, perform "Extract Planes and Pipes" beforehand.
Refer to "Extracting Planes and Pipes" in "InfiPoints Operation Manual Vol.1 Data Pre-

processing” for details.

[# 3 |£|SmartFilter ~|  SinfiPoints
Home ImportI Pre-process I Analysis Modeling Cutput Creation Recent Help

"'“ .11 Define the origin ~ | %, Create Reference Point = | 4.~ | -'z::\::\‘., L 3"\ A
= Move Point Cloud —t — == — -
Start R Remove Extra Extract Planes
Registration [ [+ Fitto CAD / Polygon Model Fal Noiser | Text and Pipes
Register Reference Point Filter Extract Primitive

[Extract Planes and Pipes] automatically extracts planes and cylinders in
the point cloud data thoroughly. If excess piping elements are extracted
such as thin pipes, bulk delete them using [Delete Excess Element] ( I:ﬂ ).
Refer to 2.1.1, “Deleting All Excess Pipes” for details.

Extract planes and pipes

o Completed feature (plane/pipe) extraction.

Select the next process

—> Delete unwanted piping elements with [Delete Excess

Elements]
Q This will increase the werk efficiency in the post processes.

= Finish

v

Delete all piping groups that satisfies any of the following conditions:

Consists of a single element which is shorter than m

[] average outside diameter of straight pipes is smaller than ~ 0.05 m

Delete Excess Element
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* If the pipes are not displayed in the 3D View Window, select [Home] tab > [Display

Status] > [Show Piping Elements] ( E] ).

[ | smart Fitter | FInfiPoints

Import Pre-process Analysis Maodeling Cutput Creat

— - et )jkg B EEE
Fit Change‘}, |D 'E'J"s%ﬁ}

View e |
View Operation Display Status
0 Click [Show/Hide Pipes] to change from [Hide Pipes] ( @ ) to [Show
Pipes] ( [] ).

In this section, the pipes are displayed as "Classify by Piping Type" ( H g )
Q for better visibility in the 3D View Window. This is a function to display

pipes in different colors according to the piping group.

* Select [Modeling] tab > [Piping] from the Ribbon menu.

| ) ~ \Smart Filter © ;l?lnfiPoints
Home Import Pre-process Analysisl Modeling I

Piping tructure Flane Duct

[Pipe Modeling Tool] tab appears. Use the pipe modeling function to create the model.

= InfiPoints Maodeling Tool
ialysis Madeling Cutput Creation Recent Help Pipe
ﬂ B Maove Vertex of Straight Pipes 4t @ & ™ Q
! Divide Straight Pipes $ 3 g
Edit Straight Edit Straight ) @ = Piping Merge
Pipe Diameter Pipe Length ﬂ Edit Boxes S " T Elements Coaxial Pipes U
Edit Delete Merge
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2.1. Deleting Pipes

[Extract Planes and Pipes] automatically extracts planes and pipes thoroughly. Use this filtering
function to delete excess elements for other software’s modeling and improve efficiency of
downstream processes.

2.1.1. Deleting All Excess Pipes

1. Select [Pipe] tab > [Delete] > [Excess Element] ( Iﬁj ).

Modeling Tool
Cutput Creation Recent Help Plane
a I ,ﬂ Move Vertex of Siyaight Pipes it K\ "r 3 Piping Groups g
! Divide straight P Sz = &a Excess Element
Edit Straight Edit 5traight i @. Piping Merge
Pipe Diameter Pipe Length (@ Edit Boxes ~1 "1 7| Elements Coaxial Pipes

Edit Delete

2. [Delete Excess Element] dialog will appear. Check [Consists of a single element which is
shorter than].

Delete Excess Element bt

Delete all piping groups that satisfies any of the following conditions:

Caonsists of a single element which is shorter than 0.5 m

[ Average outside diameter of straight pipes is smaller than  0.05

Run Cancel

The piping elements to be deleted in the 3D View Window will be highlighted in red.

3. Click [Run]. The piping elements will be deleted.
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2.1.2. Deleting Piping Elements

1. Select [Pipe] tab > [Delete] > [Piping Elements] ( ﬁ( ).

Maodeling Tool
Cutput Creation Recent Help Plane
& I B Move Vertex of staight Pipes @1 ,{\ B( B Fiping Groups g
! Divide Straight Pi m—@—iﬁ-} 3 Excess Element
Edit Straight Edit Straight _ . & = Fiping Merge
Pipe Diameter Pipe Length (@ Edit Boxes 5% "1 7 | |Elements Coaxial Pipes
Edit Delete

2. Pick the Pipes you want to delete on the 3D View Window. The Pipes will be deleted.

Q Use [Piping Groups] ( L@ ) to delete piping groups.
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2.2. Creating Pipes

2.2.1. Specify Points and Create New Piping Elements (Straight

Pipes)

1. Select [Pipe] tab > [Create Straight Pipe] > [Based on Point Cloud] ( i% ).

[ #3053 <%~ Smart Filter » EinfiPoints Modeling T
Home Impart Pre-process Analysis Modeling Qutput Creation Recent Help I Pipe I
*@ % i A4, Addto End ~ i Move
Erterrr Ry Divid

Extract Planes Create onnect Insert to | Edit Straight Edit Straight

and Pipes Straight Pipe~ [traight Pipes Straight Pipe~ §~ Connect by Route Search | pipe Diameter Fipe Length (8 Edit E
Extract Primitive | [J.  Based on Point Cloud

2. "Option" dialog will appear. This time, select "Auto-calculate from point cloud" for Pipe outer

diameter and "Select 2 points on pipe ends" for Pipe axis.

oten @
ﬂ'ﬁ‘ Option

Pipe outer diameter

(®) Auto-calculate from point doud

()setareference value | 0.01 |m

() Select 2 points on pipe surface

Fipe axis

(®) Select 2 points on pipe ends

() Create a vertical pipe

() Create a horizontal pipe

(_JParallel to selected straight pipe

() Perpendicular to selected plane
Adijust axis to fit to point doud

Existing error 0.01 |m

3. Pick two points at the position where pipes will be created in the 3D View Window.
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0 Pick two points to be approximately parallel with the axis of the new pipe.

The new pipe with the specified two points at both ends of the length will be created based
on the point cloud close to the picked points.

4. Click [Cancel the selection and quit this function] ( Q ) or press [Esc] key to exit the
command.

2.2.2. Specify Size and Create New Piping Elements (Straight Pipes)

1. Select [Pipe] tab > [Create Straight Pipe] > [At Specified Location] ( Ein ).

~ Smart Filter +|  FInfiPoints Modeling T
Home Impart Pre-process Analysis Modeling Qutput Creation Recent Help

l (1 A, Addto End ~ : 3 B Move
T T~ . L
Extervd-SasiingFipiog . 1
Create Connect Insert to Edit Straight Edit Straight .
Straight Pipe~ BT3GRt Bipes Straight Pipe~ § Connect by Route Search | pipe Diameter Pipe Length (8 Edit E

Create
3

L
Extract Planes
and Pipes
Extract Primitive

. Based on Point CI\d

2. [Option] panel will appear. Specify the standard name or the pipe radius and length in the
"Size" tab. In this case, a standard straight pipe (50A) with a length of 1m will be created.

Tree

Option % |
ﬁﬂ Option

Size Layout plane

(®) Standard: 208 [

() Radius 0.1

Extend by connecting straight pipes and.or elbows

3. Specify the orientation of the pipe to be placed from "Layout plane" tab. In this case, click
[Arrow] ( I3 ) to select an existing straight pipe and set the orientation.
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a‘ﬁ‘ Option

| Size Layout plane
Orientation: (@ Horzontal(XY) () Vertical(X2)

Yaw angle: [d=q]
Pitch angle: [dEQ]

Snap Angle: | Every 90 degrees |

Extend by connecting straight pipes and/or elbows

4. Select a pipe on "3D View" window facing the same direction as the plane (layout plane)
where the pipe’s axis will be created.

5. Layout plane is set, and the newly created straight pipe can be previewed on "3D View"
window. Specify the position to place the straight pipe.

6. A straight pipe is created. Select a white guide line on the side of the created straight pipe
where you want to add.
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Specify the side to add a new element to extend the piping element.

The side to add the pipe is set. If necessary, continue to create pipes based on that point.

Elace a new piping element.

While creating the pipe, if you wish to change the direction, you can
change the setting in [Option] panel.

Option
'n_n_ Ciption

Layout plane
Q Orientation: () Horizontal(XY) () Vertical(XZ)
Yaw angle: E = | [Heq]
Pitch angle: IE | [deq]

Snap Angle: | Every 45degrees v

Bbowtype:  (® Short radius () Long radius

7. Click [Cancel the selection and quit this function] ( @ ) or press [Esc] key to exit the
command.
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2.2.3. Connecting Pipe Elements (Straight Pipes)

1. Select the [Pipe] tab > [Create] > [Connect Straight Pipes] ( ﬂ’ ).

~ Smart Filter = ¥ InfiPoints Modeling T

ﬁ Home Import Pre-process Analysis Modeling Qutput Creation Recent Help m
::r-_':—] E_\(\ EE A, Addto End ~ ﬁ I Move
—= L Dividh

o Enterrd-ErrTrgriTY

Extract Planes Create Connect nsert to . Edit Straight Edit Straight .
and Pipes Straight Pipe < Straight Pipes traight Pipe= §  Connect by Route Search | pipe Diameter Pipe Length @ Edite
Extract Primitive Create

2. In [Option] panel, specify the type of connection part. This time, select "Elbow".

Option
aﬂ Option

(JFlange

(®) Elbow
(@) Fit to point doud

(_iShort radius elbow () Long radius elbow
() Reducer

3. Pick two straight pipes in the 3D View Window to connect them.

Picked pipes will be connected and it will become one piping group.
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ﬂ The created piping group will be added to the piping group to which the
first-picked pipe belonged.

2.2.4. Extending Piping Elements (Straight Pipes)

1. Select the [Pipe] tab > [Create] > [Extend Existing Piping] ( f;?ﬁ ).

©) ¥ ¥t~ Smart Filter | FInfiPoints - Modeling Tool
Home Import Pre-process Analysis Modeling Qutput Creation Recent Help m
i u[ o | 2
— 3 + gk L #! Divic
Extract Planes Create Connect Insert to Add t Extend Connect by Edit Straight Edit Straight
Existing Pipin

and Pipes Straight Pipe = Straight Pipes Straight Pipe~ End - Route Search| Pipe Diameter Pipe Length Ij Edit
Extract Primitive Create Ed

2. Pick the straight pipe you want to extend on "3D View" window.

o [Option] panel will appear as well; however, this time, you do not need
to change the default settings.

0 o If you select a straight pipe with no connecting elements on both ends, a
white guide line will appear on both ends. Select the white guide line on

the end to connect first.

3. A guide will appear. Drag the guide in order to extend the selected straight pipe, and left-
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click at the preferred position.

4. Click [Cancel the selection and quit this function] ( Q ) and confirm the length of the
straight pipe.

2.2.5. Adding Piping Elements(Flange, Box, Valve)
[1] Adding piping elements in the middle of the straight pipe
Below is the way to add piping elements (flange, box, valve) in the middle of the straight pipe.

1. Select [Pipe] tab > [Create] > [Insert to Straight Pipe] > [Insert Flange] ( %*, ).

=) 2~ Smart Filter = FInfiPoints - Modeling Toal
Home Import Pre-process Analysis Modeling Qutput Creation Recent Help

29 [ fo ) ﬂ 3 mov
— E\) 65 %1- &+ i @I @1 owic
Extract Planes Create Connecdt Insert to Add to Extend Existing Connect by Edit Straight Edit Straight
and Pipes | Straight Pipe » Straight Pipe|||Straight Pipe~ |End ~ Piping=  Route Search | Pipe Diameter Pipe Length (B Edit

Extract Primitive Ii+ Insert Flange I Ed
Tree @, Insert Box
Overview Pipe  Plane  Structure  Duct &y Insert Valve
e P
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o Select [Insert to Straight Pipe] > [Insert Box] ( @+ ) to add the box.

o

Select [Edit Boxes] ( ﬂ ) to change the size or the direction of the box.
Q o Select [Insert to Straight Pipe] > [Insert Valve] ( n.%g ) to add the valve.

- Select [Edit Valve Handle] ( g\ ) to change the size and the direction of
the valve. Please refer to 2.3.4, “Editing the Valve Handles” for details.

2. Pick the straight pipe in the 3D View Window to add the flange. The flange will be added at
the picked position.

[2] Adding piping elements to the end of the straight pipe
Below is the way to add the piping elements (flange, box) to the end of the straight pipe.

1. Select [Pipe] tab > [Create] > [Add to End] > [Add Flanges to Ends of Straight Pipes] ( ,i,,_ ).

P | ¥ ¥ - smart Filter ~ | FinfiPoints - Modeling Tool
Home Import Pre-process Analysis Madeling Cutput Creation Recent Help m
@ il @ ml -
— RS + + | B

.
a Divic
i
Extract Planes Create Connect Insert to Add to |Extend Existing Connect by Edit Straight Edit Straight §
and Pipes Straight Pipe = Straight Pipes Straight Pipe <) End ~ Piping = Route Search | Pipe Diameter Pipe Length Ij Edit
Extract Primitive Cfﬁt‘li, Add Flanges to Ends of Straight P\pesl Ed
Tree L < | - & Add Boxes to Ends of Straight Pipes
[ = o P

Select [Add to End] > [Add Boxes to Ends of Straight Pipes] ( &,,_ ) to add

Q box.

Select [Edit Boxes] ( ﬂ ) to change the size or the direction of the box.

2. Pick the straight pipe in the 3D View Window to add the flange. The Flange will be added at
the picked end.
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2.3. Editing Pipes

2.3.1. Adjusting the Length of Piping Elements

1. Select [Pipe] tab > [Edit] > [Edit Straight Pipe Length] ( _E ).

~ |Smart Filter = FInfiPoints Modeling 1
Haome Impaort Pre-process Analysis Maodeling Cutput Creation Recent Help

o0 [ ﬂ\) Eig % A, AddtoEnd ~ ﬂ
— 3 * 5 Bdend Bxsting Piping 3! Divide

Extract Planes Create Connect Insert to Edit Straightd Edit Straight
and Pipes Straight Pipe= Straight Pipes Straight Pipe~ §  Connect by Route Search | pipe Diamete] Pipe Length

Extract Primitive Create

¥ EditB

2. Pick the straight pipe to edit in "3D View" window.

3. Pick one of'its edges to edit.

4. "Edit Straight Pipe Length" dialog will appear. This time, select "Specify by preview (To any
location)" and click [Edit]. ("Also move connected elements as is" option is disabled)
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Edit Straight Pipe Length *

() spedify by the final length 0.262429

() Spedify by a pointin “30 View" Edit

(®) spedify by preview (To any location) Edit
I [ Also move connected elements as is

Cancel

5. The preview will be updated as you move the mouse cursor. Left-click at your desired length
to extend or shorten the structural element.

6. In "Edit Straight Pipe Length" dialog, click [OK]. The change of the length is fixed.
Like in this case, if "Also move connected elements as is" is disabled and the length of the
straight pipe connected to an element such as "elbow" is changed, the shape of that element
will change accordingly.
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2.3.2. Adjusting the Outside Diameter of the Straight Pipes

1. Select [Pipe] tab > [Edit] > [Edit Straight Pipe Diameter] ( ﬂ ).

[ #3905 % %~ Smart Filter = FInfiPoints - Modeling Taol
Home Import Pre-process Analysis Modeling Cutput Creation Recent Help I Fipe

Wk o 4o Fla]m

- + + 3! biv

i
Extract Planes Create Connect Insert to Add to Extend Connect by Edit Straight [Edit Straight |
Straight Pipe~ Straight Pipes Straight Pipe~ End~ Existing Piping Route Search | Pipe Diameter [Pipe Length ﬂ Edi

Create

and Pipes
Extract Primitive

2. Pick the straight pipe to edit in "3D View" window.

Select a straight pipe to edik.

T
N

1 j = 5
: o8 - 3
‘¢ Pinine Elemence; SEraiohmooBdee 2D
N H X
' v -
N T
% P
| :

-

3. Pick either the end part or the center part.

Specify which section (either end or middle} to edik.

4. "Edit Straight Pipe Diameter" dialog will appear. This time, select [Specify by preview],
enable "Align connected elements when editing the piping axis", and then click [Edit].
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Edit Straight Pipe Diameter *
(®) Spedfy by preview
Align connected elements when editing the piping axis
() spedify by the final diameter 0.163449
Conce

When "Align connected elements when editing the piping axis" is enabled,
the position of the adjacent piping elements will also change to match the
edited straight pipe.

5. The "3D View" window will switch to [Section Mode]. Hold down the left mouse button and
drag the handle to adjust the size and center position of the outside diameter. Then press
[Done] ( 0 ).

EEE! nuujg !:mu: !!!m: piping axis (center n! !! .:m:!e! !y EEE! nuujg !:mu: !!!m: piping axis (center n! !! .:m:!e! !y

- Red arrow handles (<®) allow you to change the size of the outer shape.

Q > Yellow arrow handle ( © ) allows you to change the center position of
the straight pipe.

6. In "Edit Straight Pipe Diameter" dialog, click [OK]. The adjustment of the size of the outside
diameter will be fixed.
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2.3.3. Replacing Boxes with Valves

1. Select [Pipe] tab > [Edit] > [Replace Box with Valve] ( L.,?g ).

Modeling Tool
elp Fipe
a Ia .ﬂ Move Vertex of Straight Pipes @I Move Flange &,
] ] ] : ! Divide Straight Pipes %. Edit Space between Paired Flanges &,
Edit Straight Edit Straight | . |
Pine Dian STEP-PIRE TERET+ | @; Replace Box with Valve G

Edit

2. Pick the box to be replaced with the valve in "3D View" window.

Picked box will be replaced with a valve.
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2.3.4. Editing the Valve Handles

1. Select the [Pipe] tab > [Edit] > [Edit Valve Handle] ( E\ ).

Madeling Tool
Pipe
1 % )
lﬂ i;g El 1 e > ? s
Edit Straight Move Vertex of Divide Edit Move Edit Space between Replace BoxjEdit Valve § Copy
Fipes Straight Pipes Straight Pipes Boxes Flange Paired Flanges with Valve § Handle 2

Edit
2. In [Option] panel, select "Edit handle orientation".

Option % |

ﬁﬂ Option

(®) Edit handle orientation

(O Edit handle size

3. Pick the valve to edit its handle direction in "3D View" window. Adjustment handle will be
displayed.

4. Move the mouse cursor in "3D View" window to change the direction of the adjustment
handle. Left-click the mouse at any position to fix the direction.
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5. Select [Edit handle size] in [Option] panel. Adjustment handle will turn to the mode for
adjusting the size of the valve handle.

Option % |

ﬁﬂ' Option

() Edit handle orientation

(®) Edit handle size

6. Move forward and back the mouse cursor in "3D View" window to change the length of the
valve handle along the guide line.

Move the mouse cursor left or right to change the size of the valve handle along the guide
line.

Left-click at any point in "3D View" window to fix the size of the valve handle.

7. Click [Cancel the selection and quit this function] ( 0 ) or press [Esc] key to exit the
command.
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2.3.5. Merging Straight Pipes
[1] Merging Coaxial Straight Pipes

Below is the way to merge two or more straight pipes whose axes and the outside diameters are
almost the same.

1. Select [Pipe] tab > [Merge] > [Merge Coaxial Pipes] ( ‘3 ).

Modeling Taol
Pipe
& & Piping Groups g a ﬁ E-B 7
3
Piping Merge Delete Flanges / Eliminate All Merge All Individual
Elements Coaxial PipesfComplement Pipes Complement Pipes Connected Pipes = Selection
Delete Merge

2. Pick the straight pipes to merge in "3D View" window and press [Done] ( 0 ).

When the following dialog is displayed, select the pipes whose axes'
direction and the radius are almost the same.

0 InfiPoints *

I Select gylinders with nearly the same axis and radius as the
current cylinder

"Merge Coaxial Pipes" dialog will appear when there is another straight pipe or flange
between picked straight pipes.
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Merge Coaxial Pipes >

(") Merge while removing piping elements in between
() Merge while keeping piping elements in between

(®) Merge while keeping flanges

Cancel

3. Specify how to process the piping elements between the straight pipes. This time, select
"Merge while keeping flanges" and click [OK].

Picked straight pipes will be connected while highlighted flange will be kept.
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Use [Merge All Connected Pipes] ( E_P ) to connect all selected straight
piping elements.

[2] Merging Straight Pipes by Deleting Flanges and Complement Pipes

Below is the way to merge straight pipes by deleting flanges or complement pipes between
them.

1. Select [Pipe] tab > [Merge] > [Delete Flanges / Complement Pipes] ( E ).

Modeling Tool
Pipe
& & Piping Groups a E ﬁj =
::-13
Piping Merge Delete Flanges / Eliminate All Merge All Individual
Elements Coaxial PipesjComplement PipesfComplement Pipes Connected Pipes = Selection
Delete Merge

2. Pick complement pipes or flanges to delete in "3D View" window. The straight pipes on both
sides are joined into one straight pipe.

If the point cloud is insufficient to generate a pipe for reasons such as a

0 part of one piping being hidden, the complement pipe will be inserted
there by the estimation during the automatic extraction. The complement
pipe is displayed in dark blue (in case of default setting.)

Q Use [Eliminate All Complement Pipes] ( E ) to delete all complement pipes
and connect straight pipes.
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2.4. Copying and Moving Pipes

2.4.1. Copying Piping Group

1. Select [Pipe] tab > [Copy Piping Group] ( &) ).

Maodeling Toaol

lelp
I ,ﬂ Move Vertex of Straight Pipes @I "_{ Ti Piping Groups g E C
) ’ @I Divide Straight Pipes '3-— p) i nﬁa Excess Elements g E
i‘ij;ljteslzilgth T OORES Elzlr?'ll:n%:s CoaTieaqueipes E) r

Edit i3, Copy Piping Element

I " Copy Piping Group I

Copy All Piping Groups to Another Piping System

O Use [Copy Piping Element] (#g) to copy per piping element.

2. Select piping group(s) to copy in "3D View" window, and click [Done] ( 0 ). The guide will
appear for the selected piping group(s) at the last-clicked location.

3. Click [Done] ( 0 ) to continue copying piping groups.
Click [Cancel the selection and quit this function] ( O ) or press [Esc] key to exit the
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command.

0 The axes of the guide correspond to the X/Y/Z directions of the world
coordinate system.

2.4.2. Moving Piping Group

1. Select [Pipe] tab > [Move Piping Group] ( =3 ).

Maodeling Tool

Help Flane

#1 Move Flanfe T B Piping Groups g
%—- Edit Space L [‘J}-j Excess Element
= Merge

P+ Replace Box with Valve |:j Mave Piping Group | Coaxial Pipes
!.’

'_'_. Mowve All Piping Groups

2. Select piping group(s) to move in "3D View" window. The handles will appear for the
selected piping group(s).

' You cannot select only some of the piping elements in the piping group.

3. Drag the handles to move the selected piping group(s).
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You can also move by specifying the values in [Move] panel. Please refer to
[Move] in Elysium InfiPoints Operation Manual Vol.2. Point Cloud
Utilization - Simulation & Data Utilization for the operation in [Move]

panel.
Maove H
Q Farallel move Rotation maove
® Relative () Absolute World coordinate system

Transhte distance )(|U |M Y|D |U‘ Z|D |U‘ 2 | (m)

Pitch 0.1 = (m)

Orientation: @) Rotation axis O XY (Top) O ¥Z(Right) O XZ(Front) = Section
No Snap Move Restore

4. Click [Cancel the selection and quit this function] ( 0 ) to finalize the move and exit the
command.

2.4.3. Moving the End of Piping Elements (Straight Pipe)

Below is the way to move the end of the straight pipes. This is useful when the straight pipes
cannot be connected since their position do not match.

1. Select [Pipe] tab > [Move Vertex of Straight Pipes] ( 3 ).

Modeling Tool

Cutput Creation Recent Help I Flane I
a I& I;a Move Vertex of Straight Pipes I}I Mave Flange )N &

! Divide Straight Pipes :} Edit Space between Paired Flanges -5 =

Edit Straight Edit Straight § @. . Fiping
Pipe Diameter Pipe Length (@ Edit Boxes 1 Replace Box with Valve i T | Elements

Edit

2. Select a straight pipe in "3D View" window.
Select a straight pipe which is connected to a piping element at one end, and not connected
to other elements at the other end.

#2 ELYSIUM © 2023 Elysium Page 63 | 145


InfiPoints_Operation_Manual_02_Data_Utilization_en.pdf
InfiPoints_Operation_Manual_02_Data_Utilization_en.pdf

Elysium InfiPoints Operation Manual Vol.3. Point Cloud Utilization - Modeling -

3. Move the end in "3D View" window, and left-click to finalize.

o When selecting a straight pipe with 1 free end, the free end will be
rotated while fixing the other end. The length of the straight pipe will

ﬂ remain as is.

o When selecting a straight pipe with 2 free ends, the straight pipe will be
rotated while fixing the rotation center at the center of the straight

pipe.

4. Click [Cancel the selection and quit this function] ( O ) or press [Esc] key to exit the
command.
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2.5. Replacing Pipes with Standard Parts

Below is the way to replace modeled piping elements with standard parts.

2.5.1. Replacing All Piping Elements with Standard Parts

1. Select [Pipe] > [Standard Parts] > [Replace All] ( I!{T' ).

Modeling Taaol

| Poe |

- I Eliminate All Complement Pipes Lr ﬂ Settings on Standard Parts
Merge ) Individual
Coaxial Pipes “ Merge All Connected Pipes Selection
Merge | Standard Parts

2. "Replace All Elements with Standard Parts" dialog will appear. Set tolerances and click [OK].

Replace All Elements with Standard Parts X

Tolerance for diameter mm

Tolerance for angles IZ' degree

Flange Standards to Prioritize Auto w

[ ok ]} cance |

The piping elements will be replaced with standard parts fulfilling the specified conditions.
Select [Highlight Standard Parts] ( E g ) to display each standard pipe in colors.
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* [Highlight Standard Parts] ( EEI] ) can be selected from [Home] tab >
[Display Method of Piping Elements].

= FInfiPoints

Analysis Modeling Qutput Creation Recent
=1 F nik =22 . .
= 5 0 . - = e (1] ; 1 -
Fit  Change P~ |[_| = u\|, ® - :E Default Color
View = | L2 | o
Q Classify by Piping Group
View Operation

Highlight Standard Parts
Tree a B

Overview  Pipe  Plane Stucture Duct
-8 Model
-3 Scans

Show Axes of Piping Elements
Texture

Classify by Pipe Type

* Use [Individual Selection] ( 3§ ) to replace only the specified piping
elements with standard parts.
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2.6. Aligning Pipes

Below is the way to align the axes of the modeled piping elements to connect each pipe

adequately.

2.6.1. Aligning All Axes Directions of Piping Groups

1. Select [Pipe] > [Align] > [Align All Elements] ( =g ).

Modeling Tool

Recent Help

Pipe

& Piping Groups
£ Excess Elements
Piping
Elements
Delete

2

w
o |

%

i

Merge
Coaxial Pipes ﬂj

Merge

Individual
Selection

Standard Parts

Align Piping Align All
Group Elements

Align

?@

Set Pipe
Type

Far Rebro

2. "Align Piping Elements Automatically” dialog will appear. Set the angle tolerance and the

aligning option, and click [OK].

Align Piping Elernents Automatically

Angle tolerance to be considered harizontal

Angle tolerance to be considered vertical

Alsa align horizontal pipes to X or Y axis

s

Angle tolerance of elbows with 90 and 45 deagrees EI degree(s)

EI degree(s)
EI degree(s)

Cancel

All piping group’s axes will be aligned to fulfill the specified conditions.

>

Q Use [Align Piping Group] ( 1§ ) to align only specified piping groups.

2 ELYSIUM © 2023 Elysium

Page 67 | 145



Elysium InfiPoints Operation Manual Vol.3. Point Cloud Utilization - Modeling -

2.7. Editing Piping Tree

The structure of the piping elements is displayed in the [Tree (Pipe)] panel. This can be useful in
cases such as:

* Classifying piping elements into groups such as a "Cooling System" or an "Exhaust System."
» Switch between show and hide of the "Cooling System" piping group.

* Export only the "Cooling System" piping group to a CAD system.

2.7.1. Checking Pipes on [Tree (Pipe)] Panel

* Check the structure of the piping elements in the [Tree (Pipe)] panel.

— B Supported types of pipes:
D'-.-'er'-.fieul Fipe I:‘Iane Structure  Duct « Straight Pipe ( 1D
=} &) Extracted Piping System .-h. ~
-/, Piping Group: 0 * Flange ( %)

. Piping Group: 1

: [| Straight Pipe: 13
™ Elbow: 23

[l Straight Pipe: 11
[ 4 Flange: 21

.} [| Straight Pipe: 9

Elbow ( [7)

Pipe Tee ( [F)

Reducer (/)

Valve ( %)

Others ( ()

* By selecting piping elements or piping groups in the [Tree (Pipe)] panel, they will be
highlighted in the 3D View Window.

o When selecting a plane system on [Tree (Pipe)] panel

Tree

Overview PiPe  Plane Structure Duct

=70 Extracted Piping System
. Piping Groyp; 0

IS, Piping Group: 17
-}, Piping Group: 37

<
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Also, by selecting piping elements or piping groups in the 3D View Window, they will be
highlighted in the [Tree (Pipe)] panel.

> When a piping element is selected on "3D View" window

Tree

Overview Fipe  Plane Structure Duct
[A[l Straight Pipe: 10
- Pipe Tee: 26
| Straight Pipe: 9
i Elbow: 27
[l Straight Pipe: 1924

[ [Straight Pipe : 1925]

Reducer: 1926

[l Straight Pipe: 15
P Elbow: 20

o Change the [Smart Filter] to [Piping Element / Plane / Duct Element] or
[Piping Group / Plane Group / Duct Group] to pick piping elements or
piping groups easily.

p ! *: ~|Pipina Element /PI|~|  FInfiPoints -
Q Home Impor Smart Filter |
oo = Piping Element / Plane / Duct Element
_.. ﬂ:{, |Piping Group / Plane Group / Duct Group |
o Multiple pipes can be selected by selecting them while holding the
[Shift] or the [Ctr]] key.

* To confirm the point cloud around the selected piping, right-click on the piping element or
piping group on [Tree (Pipe)] panel, and select [Fit View to Element size] or [Display
Surroundings Only] from the context menu.

Tree |
Overvien FiPe  Plane  Structure  Duct
=-p]E) Extracted Piping System "
+- i€, Piping Group: 0
- IE, [alls 1
+ ME Fit View to Element size
+ '_-"- Display Surrcundings Cnly
+-15,
115 Delete

* Right-click on an element on [Tree (Pipe)] panel, and select "Collapse All Piping Groups"
from the context menu to close the entire piping groups.
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Overview Pipe Plane  Structure  Duct Overview Pipe Plane  Structure  Duct
=B &|] Extracted Piping System ~ =15 |Extracted Piping Syslem| ~
=8| Group Piping Groups - Piping Group: 0

+-[1E, Piping Group: 1
i-I1E, Piping Group: 5
H-]IE, Piping Group: 8
i-.1IE, Piping Group: 15

Display Method of Piping Elements
Al Straight Pipe: 2 > H-1IE, Piping Group: 17

[
[
[
[
[
=-E, Piping Group: 1 #-IE, Piping Group: 37
[A[] Straight Pipe: s #-E, Piping Group : 44
[
[
[
[
[

A Others: 7 i-#1S, Piping Group : 52
pIng P
Al Straight Pipe: & 2 [ZTE Piping Group :
it Fip ping p
EI@E Piping Group: 5 1 Piping Group :
=[] Straight Pipe: 42 2 [ATE Piping Group : 69
- gnE P ping Group
+-(1E, Piping Group : 70 ]

&7
68

- PipeTee: 43 v

* Check the property of the selected piping elements or piping groups in the [Property] panel.

[ Coordinate system (World coordinate svstem) 1 .
Piping Group [1]
Mumber of Elements: 23
Straight Pipe: 15
Flange: 4
Elbowe: 4
Mumber of Branches: 0
Loop: Does Mat Exizt
Length: 104177 m

2.7.2. Creating Piping Groups

1. Right-click "Extracted Piping System" at the top of [Tree (Pipe)] panel, and select [Grouped
Piping Groups] in the context menu to create a "Grouped Piping Groups" folder.

Overview PiPe Plane  Structure  Duct Cverviews FIPe  Plane  Structure  Duct
(=B ¥als)] Extracted Piping System -5 &) Extracted Piping System A
E E: _' > @ Grouped Piping Groups
@E':\ FIpTgaroupT EE Piping Group: 0
@E Fiping Group: 2 EE Piping Group: 1
@@ Piping Group: 3 @E Piping Group: 2

2. Drag and drop the piping group to the created group folder to move into the group.

Overview FPipe  Plane  Structure  Duct

=[] 51 Extracted Piping System ~
: Grouped Piping Groups
@E Piping Group: 0
@M TE Piping Group: 1
@E Piping Group: 2
12 Piping Group: 3
[ 1 Piping Group : 4
e Piping Group: 5
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Q It is also possible to further break down groups into smaller subgroups.

Overview PiPe Plane  Structure  Duct
=[] &) Extracted Piping System ~
-3 Grouped Piping Groups

E| [(3 Grouped Piping Groups
@E‘; Piping Group: 0

E @EE, F'ipimi Group: 1
-1, Piping Group: 2
w-0 Piping Group: 3

[ v Piping Group: 4

2.7.3. Renaming Pipes

* Right-click on the group, piping groups or piping elements in the [Tree (Pipe)] panel and
select [Rename] to change the name.

Overviews Fipe  Plane  Structure  Duct Cwerview Fipe  Plane  Structure  Duct
EEE Extracted Piping System -~ =151 Extracted Piping System ~
=B8] Grouped Piping Groups —{[¥13 Air Conditioning System

E@D & Fit View to Element size

E@D West Area
-1 Display Surrcundings Only > E

WS West: 0
{ S West: 1

=

= HE P Delete -b 1S, Piping Group: 2
@113 Pipir Move m-b & Piping Group: 3
w-MIE Pipir Fememrz Mg Piping Group: 4
#-BA1E Pipir w-[AE, Piping Group: 5
5-AE Pipir Group Piping Groups w-IE, Piping Group: &

o It is also possible to rename by selecting the group, piping groups or
Q piping elements in the [Tree (Pipe)] panel and pressing [F2].
o Delete the name by using the [Backspace] key to reset the changed
name.

2.7.4. Showing / Hiding Pipes

* Click the check box left of the group, piping group, or piping element in the [Tree (Pipe)]
panel to switch the show/hide status of pipes.

Overview FPipe  Plane  Structure  Duct Overview  PiPe Plane  Structure  Duct

A =15 (5 Extracted Piping System ~

=-[4(23 Grouped Piping Groups
< I Ean

Fiping Lroup: U

EL_-_., Piping Group : 1
=T Piping Group: 2 = WE] Piping 12
[ Elbow: 1271 w1 Elbow: 1271

[ T[] Straight Pipe: 1276
@ [ PipeTee: 1275 L[F PipeTee: 1275
LAl Straight Pipe: 1272 “[ ][] Straight Pipe: 1272
(-5 T Piping Group: 3 -l Piping Group: 3

@ [l Straight Pipe: 1276
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o By clicking the check box of each piping element will switch show/hide
status of the piping group which the element belongs to.

Overview  PiPE Plane  Structure  Duct

=1l £ Extracted Piping System A
=-[E3 Grouped Piping Groups
E IE, Piping Group: 0

[1[F PipeTee: 1275

..... [1[] Straight Pipe: 1272

0 -2 T Piping Group: 3

o Click the check box of [Extracted Piping System] in the [Tree (Pipe)]
panel to switch the show/hide status of piping system.

Overview Pipe  Plane  Structure  Duct
=15 Model

B-E] Scans
EED Group1
E]o 20150217A-1
[ 20150217A-2

[ 2015021742

IM] W Extracted Piping System
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2.7.5. Switching the Display Method of Pipes

1. Select [Home] tab > [Display Status] > [Display Method of Piping Elements] and select the
method to color pipes from the displayed pull-down list.

FInfiPoints
nalysis Modeling Cutput Creation Rece
0 EE - - b (22 ~]| |1 - | e

-l gl - EE Default Color

8 Classify by Piping Type

45 Highlight Standard Parts

7 Show Axes of Piping Elements
J Texture

! 5 Classify by Pipe Type

- Below are the five methods to color pipes.

= Default Color ( EE )

« Classify by Piping Type ( .1 E' )

» Highlight Standard Parts ( [EIH )
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- Show Axes of Piping Elements (57 )

= Texture ( ﬂ )
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2.7.6. Changing the Display Color of Pipes

1. Select [Home] > [Display Status] > [Display Method of Piping Elements] > [Classify by Piping

go
Typel ( gg )
[ # = % < Smart Filter - EInfiPoints
Home Import Pre-process Analysis Modeling Output Creati

@I @ e 'E #[m x| E]-l= -l0]{5 - &8 -
Fit  Change (g | | [F]@ -W]-1@ & |z § B o

Display Status

View Operation

2. Right-click on the piping group or the group to change the display color in the [Tree (Pipe)]
panel, and select [Edit Display Color....] in the context menu.

Tree B
Owerview Fipe  Plane  Structure  Duct
=-I~] 5] Extracted Piping System .n.
m-ME

Piping Group: 0

- g

=-MTE Fit View to Element size

" E Display Surrcundings Cnly
B-ME

=-ME Delete

-- T, Pif Move

" E Rename

w-ME

i 1 T I Edit Display Color.. I
AT

3. "Color" dialog will appear. Specify any color your prefer, and click [OK].

s

Color

Basic colors:

_ Sl Sl 0 0
- .
C R
C R
T
T i

Custom colors:

171
171
171
171
171
171
171
171

Cefine Custom Colors =

Ok, Cancel

The specified display color will be reflected.
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Tree B
Crverview  FPipe Plane Structure  Duct
=[] &) Extracted Piping System ~

RN Piping Group: 0

To clear the selected color, right-click on the color edited piping group or
the group and select [Reset to Default Color].

Tree B

Overview Fipe  Plane  Structure  Duct

Extracted Piping System ~

Fit View to Element size

Display Surroundings Only

Delete
Mowve

Rename

Edit Display Color...
Reset to Default Color
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3. Structure Modeling

In structure modeling, you can easily create a structure model by deleting unnecessary
structures or changing the geometry of existing structures based on a group of structures
automatically extracted from the point cloud data.

Preparing for Structure Modeling

« If structures are not displayed, select [Home] tab > [Display Status] > [Show/Hide
Structure] ( [Lf' ). Similarly, select [Show/Hide Plane] if planes are not displayed.

[ smart Fiter ~|  EinfiPeints
Impart Pre-process Analysis Maodeling Qutput Creat
— i ol -
At Change g o \[] 5 -B]-@ -5 § B0
View Operation Display Status
o Click [Show/Hide Structure] to change [Hide Structural Elements] ( [f )
and [Show Structural Elements] ( (] ).

» Select [Modeling] tab > [Structure] from the Ribbon menu.

| 3 o - |Smart Filter - EInfiPoints
Home Import Pre-process Analysisl Maodeling I
b | b |8 %

Piping f Structure| Plane Duct

[Structure] tab will appear. Users can perform structure modeling using functions in
this tab.

| 4 ~ Smart Filter - ElnfiPoints Modeling Tool
Home  Import Pre_process Analysis Modeling Output Creation Recent  Help I Structure I

W L N, K 0 W A2 &k B ® % G '

Extract  Extract Planes Create Based Create on Create at Add Edit Maove Copy Delete Settings on Align Structure Align All Structure Close

Structure and Pipes on Point Cloud Specified Planes Specified Point Structure Standard Parts Group Structure Groups  Info (CSV)  this Tab
Extract Primitive Create Edit Standard Parts Align Data Export Exit
i - e aan
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3.1. Extracting Structure

Preparation

* In [Tree (Structure)] panel, check ON the checkbox for the point cloud part. [Extract
Structure] can be performed on a point cloud part with or without the scan index.

Tree

Overview  Pipe

Plane Structure Duct

=18 Model
=03 Scans

-5 Groupt

-[Je% LS07364_020
[ e LS07364_021
-
S
-[1:% LS07364 024
-
-

L507364_022
L507364_023

LS07364_025
LS07364_026
-[]e%, LS0T364_027

Extracted Planes

] a Extracted Piping System

:

o
i
i

Filtered_points

* If you have large-scale point cloud, you might want to perform [Optimize for
Visualization] in advance to reduce the processing time. Please refer to Elysium
InfiPoints Operation Manual Vol.1 Data Pre-processing "Creating Point Cloud Data
Optimized for Visualization" for more details.

Import

R, Colorfintensity Filtfr
.,3-, Extract Ground
'1 Extract Pole

Filter

Pre-process Analysis Maodeling Qutput Creation Recent
o A -_'::_[’—J A3 Edit .. Edit Color
T —
rﬂ =i+l U
Extract = Extract Planes | Create -
Text and Pipes - .~ Smooth out Color Gap
Extract Primitive Texture Foint Cloud Caolor

Help

Optimize for

~. Create

1. Select [Structure] tab > [Extract Primitive] > [Extract Structure] ( _! ).

Visualization =

. Backgn
1'% Point 1
+ Compl
| ot

Elnr |

[F] smart Fitter

L, Extract Planes and Fipes

-

.

£ InfiPaints

-

Modeling Tool

Home Import Pre-process Analysis Modeling Output Creation Recent HeIpI Structure I

fil 22 Wy

S

Create Based Craate on Create at Add Edit Maove Copy Structure
on Point Cloud Specified Planes Specified Point Structure - b
Extract Primitive Create Edit
2. In "Extract Structure" dialog, click [OK].
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Extract Structure

scan index.
Click [OK] to continue.

Extracting structure primitives from the shown point cloud without

Gance

Structure primitives are extracted.

If you set up the Clipping Box, enable "Hide points outside Clipping Box" in
[Clipping] panel, and then perform [Extract Structure], you can extract
structures only from the point cloud within the Clipping Box.

Clipping

)
t

&|-le] (o=

I Hide points outside Clipping Bo:-cl

[ [Show Box

Highlight points

[ [Section Mode
@ side
OTnp

Once the structure is created, a new structural part "Structure" will appear on [Tree

(Overview)] panel.
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Dverview Pipe Plane Structure Duct

=-1E Model
E@D Scans
-3 Group!
[ Ls07364_020

% LS07364_021

[Tt 1507364 022
LS07364 023
L507364 024
LS07364 025
L507364 026
-[Igk Ls07364 027
-[_|#F Extracted Planes
[ 8 Extracted Piping System

1 F nts
MADE Structure

e
L+

-t

-
T

3
++

& 3 &
+, 4

T

+
A
1
kY

Structural elements are displayed on [Tree (Structure)] panel. The extracted structural
elements will belong to one structure group.

Overiew Pipe Plane Structure  Duct

E--@ Structure
= Structural Group: 0
L-A00 1001318 : 0

-ME C-100x50: 1

L, L-250x250x625: 2
SPAL L-150x150x12: 3
AT CT-445%299: 4
o= F-45x450: 5
= F-16x280: 6
- F-d5x450: 7
@1:, L-25x25x3: 8
= F-45x500: 0

Q Please refer to 3.6, “Editing Tree (Structure)” for details on how to create a
structure group manually.
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3.2. Editing Structural Elements

Structures extracted by [Extract Structure] can be modified to match the geometry of the point
cloud.

3.2.1. Deleting Structure
Before you start editing structure, delete the overly extracted structures.

1. Select [Structure] tab > [Delete] ( ﬁ; ).

| FInfiPoints Modeling Tool
MOCEsS Analysis Maodeling Cutput Creation Recant Help Structure
@@ Excess Element
W R @ TF M3
Create Based Create on Create at Add Edit Move Copy Structure
on Point Cloud Specified Planes Specified Point Structure k2 k2
Create Edit Delete

2. Pick the unnecessary structure from "3D View" window. The structure you have picked is
deleted.

o Please note that structures can be deleted continuously.

By deleting the overly detected structures, you are now ready to edit.

3.2.2. Modifying Structure Type and Size

1. Click [Structure] tab > [Edit] > [Edit] ( W‘ ).

#2 ELYSIUM © 2023 Elysium Page 81 | 145



Elysium InfiPoints Operation Manual Vol.3. Point Cloud Utilization - Modeling -

= I;:Irﬂ‘iPcuints Modeling Tool
rocess Analysis Modeling Cutput Creation Recent Help Structure
W /M | g oo
Create Based Create on Create at Add Edit JMove Copy Structure
on Point Cloud Specified Planes Specified Point Structure & =
Create Edit Delete

2. Select the structural element you want to edit on "3D View" window. This applies to
structures whose types that were not extracted correctly, structures with incorrect length,
etc.

semerume: T-team 131
L3

3. Use [Option (Property)] panel to modify the type. Here, change the type from "T-beam" to
"H-beam".
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You can also change the structure standard from [Option (Property)] panel.

Option % |

ﬁﬂ Property 2_: Tool

-
Type H-beam L
Length fm]  1.578957 )
Q Puis lies st Middle Certer Y= T

EEEE H-250¢125 [] D i
Himml |[AA50100 A el
B H-150x150
mml 4 17500
tmml §|4.175,175
t2 fmml  §|H-200x100 i
H-200x150
Standards
Select a stang 200200
H-250x175
H-25{ke 250

4. Press [2D View] in the upper right of "3D View" window to switch to 2D View mode.

==

Z0 Wiew

5. Drag green/yellow/red handles to adjust the cross-sectional size and the shape. Once you
start dragging, point for registered standards will be displayed in white circle, and you can
snap to it.

Edit in J0 view asing handles, or select an editing teol in [Option] pamel

6. Click [3D View] to switch to 3D View mode.
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7. In [Option] panel > [Tool] tab, select "Extend Structure Axis".

Option % |
L4
ﬁﬂ. Property 2_"‘ Tool

e Rotate Left 90

Y Rotate Right 90

n Rotate Z-axis 180

[ i Edit Length
| / Extend Structure Auis

'.‘?;‘.I Fit Structure to Point Cloud

8. Pick a point cloud vertex at the endpoint position on "3D View" window.
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In addition to the point cloud vertex, endpoint can also be aligned to
another element or another structure.

“: v |Structure E #InfiPoints

Impor Smart Filter
Q Plane: PoWgon Face
Polygon Vertex

Paint Cloud Vertex !
imitive CAD madel face
Reference point

Piping Element / Plane / Duct Element

Plang]
Structure

9. Press [Done] ( Q ). The structural element’s axis being edited is extended to the position
specified for the endpoint.
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About [Option (Tool)] Panel

In addition to the option "Extend Structure Axis", there are other useful tools for editing
structures. These commands are available in both [2D View] / [3D View] mode.

Option B

aﬂ Prgpert&.l 2: Tool

L Rotate Left 90

Y Rotate Right 90
[ p) Rotate Z-axis 180
[ Edit Length

f Extend Structure Axis
Fit Structure to Point Cloud

 Rotate Left 90 / Rotate Right 90

o With the structural axis as the base, these options rotate the structure 90 degrees
to the left or right.

» Rotate Z-axis 180

o With the structural axis as the base, this option rotates the structure 180 degrees to
the left or right.

#2 ELYSIUM © 2023 Elysium Page 86 | 145



Elysium InfiPoints Operation Manual Vol.3. Point Cloud Utilization - Modeling -

» Edit Length

- This option changes the structure’s length to a numerically specified value.

Edit Length

Length:

Side to fix:

1.129|

(®) Round

m

D Arrow

Cancel

x

 Fit Structure to Point Cloud

o This option moves the structure along the surrounding point cloud. This is
effective when creating a structure on a specified plane or when the structure’s
extended length moves away from the the point cloud. However, this method may

take time to calculate.

2 ELYSIUM © 2023 Elysium

Page 87 | 145



Elysium InfiPoints Operation Manual Vol.3. Point Cloud Utilization - Modeling -

3.3. Creating Structure Elements

3.3.1. Creating Structure Based on Point Cloud

1. Select [Structure] tab > [Create] > [Create Based on Point Cloud] ( ﬂ’. ).

- #InfiPoints Modeling Tool
roCess Analysis Maodeling Cutput Creation Recent Help Structure
ralri i @E}(cess Element
LU
Create Based Create on Create at Add Edit Move Copy Structure
on Point CloudiSpecified Planes Specified Point Structure 2 2
Create Edit Delete

2. Create a structural element by picking a point cloud vertex at each end of the structure to be
created on "3D View" window. You can continue creating the structural elements.

3. Click [Cancel the selection and quit this function] ( Q ) or press [Esc] key to exit the
command.

3.3.2. Creating Structures on Specified Planes

If planes are not extracted, please perform [Extract Planes and Pipes]
beforehand. Refer to "Extracting Planes and Pipes" in "InfiPoints Operation
Manual Vol.1 Data Pre-processing" for details.

A [# o e -] EInfiPoints
Home

Import Pre-process Analysis Maodeling Qutput Creation Recent Help
"@ %) Define the origin ~ i, Create Reference Point v | "5 = _\.° L A
= Move Point Cloud = = - —
Start B | Remove
Registration [ i+ Fit to CAD / Polygon Maodel Noise~ |
Register Reference Point Filter Extract Primitive

1. Select [Structure] tab > [Create] > [Create on Specified Planes] ( m ).

- #InfiPoints Modeling Tool

ﬁ éﬂ Excess Element _s‘;:%
C

‘0{ess Analysis Modeling Cutput Creation Recent Help

i | &

+la

Create Based Create on Create at Add Edit Move Copy Structure Settings on
on Point Cloud|{Specified PlanesfSpecified Point Structure < < Standard Parts
Create Edit Delete Standard Parts

2. In [Option (Property)] panel, select a structural element (such as [H-beam]) from "Type"
column.
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Option
ﬂﬂ Property %: Tool '¢'¢_ Option
5]

Tvpe

Lereth [m]

Axiz lies at
=

Standards

H [mm]

B [mm]

t1 [mm]

t2 [mm]

Type

Select a tvpe of structural element

to create.

zer Definition
L LTOrOroror

a.000000

Standard Parts can be specified by Standards column on [Option
(Property)] panel. In addition, [Option (Option)] panel allows you to specify
whether to keep or delete the two planes that form the structural element.

(Right figure)

Option

Type H-beam
Length [m]  1.395582
Aisliesat  Middle Center
=
andards  [&TEGT] E
H [mm] sto A
Bl | 0100
i H125:60
t2 [mm] H-125¢125
H-150x75
ot |15
Select a standa |4 75,90
H-175175

X
—
o

11

ﬁﬂ Property %: Tool ¢¢_ Option
= ~

- |

Option

ﬁﬂ Property %: Toal ¢¢_ Option

Whether to keep original planes

(®) Keep
() Delete

3. Select two planes (bottom and sides) that will form the structure and press [Done] ( Q ).

4. Specify the size of the structural element. Select [2D View] at the top right of "3D View"

window to switch to 2D View mode.
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==

il Wiemw

5. Drag the handles (green/yellow/red) to adjust the cross-sectional size and the shape. Once
you start dragging, point for registered standards will be displayed in white circle, and you

can snap to it.

Specify the size of structural element using round grips.

6. Press [3D View] to switch to 3D View mode again.

Cd

D Wiew

Click [Extend Structure Axis] in [Option (Tool)] panel to specify the length of the structural

element.
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Option

L4
ﬁﬂ Property %" Tool ﬁ'ﬁ' Option

'e
R
P
il

Rotate Left 50
Rotate Right 50
Rotate Z-axis 180
Edit Length

<

Exdend Structure Axis

Fit Structure to Point Cloud
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7. Select a point or a plane (or a structural element if available) to define an endpoint. You can
also select structure if you have a previously created structure.

8. Press [Done] ( o ) to create a structural element. You can continue creating structural
elements.

9. Click [Cancel the selection and quit this function] ( o ) or press [Esc] key to exit the
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command.

3.3.3. Creating Structure (Others)
m Creating Structure at Specified Point

By setting the geometry and orientation of the structural element in [Option] panel, you can
create a structural element on top of an element you pick on "3D View" window.

1. Select [Structure] tab > [Create] > [Create at Specified Point] ( ﬂ_,_ ).

- ;|= InfiPoints Modeling Tool

rocess Analysis Modeling Output Creation Recent Helpl Structure I

ml- m a., ﬁ ## Excess Element | ﬁ

Create Based Create on Create at dd Structure Settings on
on Point Cloud Specified Planes) Specified PointfStructure Standard Parts

Standard Parts

Edit Move Copy

Create Edit Delete

2. Specify the structural element information to be created in [Option] panel.

o Select Type, Standard, Length in [Option (Structure type)] panel.

ﬂ-ﬁ- Option

Layout plane / Axis  Structure type

Type: | H-beam w |

Standard: | H-100x50 w |

o [T

o Select Yaw/Pitch angle, Rotation angle and Axis location in [Option (Layout plane/ Axis
tab)] panel.

ﬁﬂ' Option

Layout plane / Axis  Structure type

Yaw angle: o % [deg)
Pitch angle: o % [deg)
Rotate at: 0 2 [deal
Puis lies at: Middle Center w
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If you wish to create a structural element parallel to an existing
structural element, use (%) in [Option (Layout plane/ Axis)] panel

Q (next to [Rotate at] field) to specify the angle by selecting a structural
element in 3D View Window. The [Rotate at] value will be automatically
updated accordingly.

3. Pick an element on "3D View" window where you want to create the structural element. A
structural element is created at the specified position. You can continue creating structural

elements.

4. Click [Cancel the selection and quit this function] ( Q ) or press [Esc] key to exit the
command.

® Adding Structural Elements

1. Select [Structure] tab > [Create] > [Add Structure] ( % ).

- #InfiPoints Modeling Tool

MoCess Analysis Modeling Cutput Creation Recent Help Structure

m @S @I’ @ #9 Excess Element

Create Based Create on Create at Structure

Create Edit Delete

2. Select a structural element to add a structural element to in "3D View" window. Click the
side to add to.
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3. Specify the structural element information to be added in [Option (Structure type)] panel.
The same settings as the selected structural element will be entered automatically. Change

the settings on the shape, etc. as required. The structure element which will be added with
the current settings will be previewed in "3D View" window.

o In [Structure type] tab, specify "Type" and "Standard".

Option
ﬁ'ﬂ Option

Layout plane / Axis  Structurs type

Type: Hbeam e

Standard: H-10050 w

o Orientation, Yaw/ Pitch angle, Rotation angle and Axis location by [Option (Layout plane/
Axis)] panel.

Option
ﬁﬂ Ciption

Layout plane / Axis  Structure type

Orientation: (®) Horizortal(XY) () Vertical(XZ)

Yaw angle: 50 > [deq]
Pitch angle: 45 = [deq]
Rotate at: 0 - [deg] |y

Axis lies at: Middle Center w

4. Click on 3D View Window to specify the endpoint, and place the defined structural element.
You can continue creating structural elements.
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> Newly created structural elements will be added to the same sub-group
as the "added to" structural element.

Tree H

Cwerview  Pipe  Plane  Structure Duct

=+ 51 Structure
=lbA(E Structural Group: 0

0 | -A3C H-beam: 0
A I-beam: s

[ﬂ Structural Group: 2
- Structural Group: 3

o Refer to 3.2, “Editing Structural Elements” to further edit (rotate, change
the length and fit to point cloud) created structural elements.

5. Click [Cancel the selection and quit this function] ( @ ) or press [Esc] key to exit the
command.
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3.4. Copying and Moving Structure

3.4.1. Copying Structure

Copy by structure element or structure group unit. This is effective when you wish to reuse a
structure, which has already been created, at a different location.

Q Select [Copy Structure Element] ( #4 ) to copy a structure element. Select [Copy
Structure Group] ( #g ) to copy structure group(s).

® Copying Structure Element

1. Select [Structure] tab > [Copy] > [Copy Structure Element] ( #4 ).

iPoints Modeling Tool
iis Maodeling Output Creation Recent Help Structure
ra]r 1] it é#Excess Element S
= ”W @
Create on Create at Add Edit Movel| Copy Structure Settings on Align Structure
Specified Planes Specified Point Structure 4 e StanErd Parts Group
Create Edit | s, Copy Structure Element I Al
L x | "w Copy Structure Group

Copy All Structure Groups to Another Structure Part

2. Select a structure element to copy in "3D View" window. The guide will appear for the
selected structure element.

0 The axes of the guide correspond to the X/Y/Z directions of the world
coordinate system.

Move a copy along the guide axes, and left-click to place the copy.
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You can also move by specifying the values in [Option] panel.

Option |

aﬂ Option

Q Distance

3. Click [Done] ( 0 ) to continue copying structure elements.
Click [Cancel the selection and quit this function] ( Q ) or press [Esc] key to exit the
command.

3.4.2. Moving Structure

The created structure will be moved to another location.

Select [Analysis] tab > [Move] ( ;.5 ) to move a single structural element. To
move a structure group or a structure part, select the move command of
structure modeling. (See below)

Madeling Tool
Pipe Structure
ﬂ [rilr's W @ %#F_xces-_Elemen

wp | M

Add Edit | Move | Copy | Delete
Structure & =

D% Move Structure Group

_? Move All Structure Groups

® Moving Structure Groups

1. Select [Structure] tab > [Move Structure Group] ( g ).
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Madeling Tool

Fipe Structure

ﬁ ﬂ -:L.’I]E 0% ﬂ #jw ExcesglElemen

Add Edit | Move | Copy Delete
Structure T <

1% Move Structure Group
__'? Maove All Structure Groups

2. Select structure group(s) to move in "3D View" window. The handles will appear for the
selected structure group(s).

3. Drag the handles to move the selected structure group(s).

You can also move by specifying the values in [Move] panel. Please refer to
[Move] in Elysium InfiPoints Operation Manual Vol.2. Point Cloud
Utilization - Simulation & Data Utilization for the operation in [Move]

panel.
Move B
Q Farallel move  Rotation move
® Relative (O Absolute World coordinate system

Translate distance X|U |M Y|U |U‘ Z|D |U‘ A (m)

Pitch 01 = (m)

Orientation: (@) Rotation axis O XY(Top) O ¥Z(Right) C XZ(Front) = Section
No Snap Move Restore

4. Press [Cancel the selection and quit this function] ( Q ) to finalize the move and exit the
command.
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3.5. Aligning Structures

This is a function to align structural elements in a same structure group automatically. You can
align either a selected group only, or all structure groups at a time.

3.5.1. Aligning Selected Structure Group

1. Click [Structure] tab >[Align] > [Align Structure Group] ( {#] ).

Modeling Tool

h,.;h 4 * Excess Element {(Ei :@ ﬁ t rﬁ
Copy Structure Settings on Align Structure Align All Structure
2 Standard Parts Grmﬂ Sfructure Groups | Info [C5V]
Delete Standard Parts Align Data Export

2. Select a structure group and press [Done] ( 0 ).

3. "Align Structural Group" dialog will appear. Specify the angle tolerance and alignment
direction, and click [OK].

Align Structural Group X

Angle tolerance I:l degree(s)

() Align to X /¥ [Z-axes
(®) Perpendicular or horizontal to Z-axis

(") align structural elements in group parallel or perpendicular

carc

The selected structure group will be aligned.

3.5.2. Aligning All Structure Groups

1. Click [Structure] tab > [Align] > [Align All Structure Groups] ( ﬁj: ).

Modeling Tool

Gfl 9 Excess Element S it m )
o b = :@ ﬁ[ﬁ] %

Copy Structure Settings on Align Structure Align All Structure
4 Standard Parts Group Structure Groupsf Info [C5V]
Delete Standard Parts Align Data Export

2. "Align Structural Group" dialog will appear. Specify the angle tolerance and alignment
direction, and click [OK].
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Align Structural Group X

Angle tolerance l:l degree(s)

() align to XY [Z-axes
(®) Perpendicular or horizontal to Z-axis

() mlign structural elements in group parallel or perpendicular

carel

All structure groups will be aligned.
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3.6. Editing Tree (Structure)

* You can edit tree structure, names, etc. in [Tree (Structure)] panel. This is to edit property
values only, and the shape and the location of structural elements will remain the same.

* CAD models are exported maintaining the tree structure, names, etc. when exporting with
[Export] ( " ). Please note that only CAD models shown in 3D View Window will be
exported.

3.6.1. Checking Structural Elements

* [Tree (Structure)] panel shows the tree structure information of structural elements created
in InfiPoints.

Tree H

Owerview  Pipe  Plane  Structure  Duct

=} &) Structure
_[ﬂ Structural Group: 0
[ H-beam: 1
[T T-beam: 2
[0 Square Pipe: 3

 Select a structural element in [Tree (Structure)] panel, and the selected element will be
highlighted in 3D View Window.

o When a structure is selected on [Tree (Structure)] panel

Tree

Overview Pipe  Plane  Structurs  Dyct
=& Structure
—-Eﬂ Structural Group: 0
Square Pipe: 1
: Square Pipe: 2
Square Pipe: 3
Square Pipe: 4
are Bipe.

Or select a structural element in 3D View Window, and the selected element will be
highlighted in [Tree (Structure)] panel.

o When structure is selected on "3D View" window
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v

Tree

Owerview  Pipe

Plane Structure  Duct

Square Pipe: 1
[O] Square Pipe: 2
[0 Square Pipe: 3
[O] Square Pipe: 4
Square Pipe: 5
H-beam: &

Select multiple structures while pressing down [Shift] or [Ctrl] key.

* To confirm the point cloud around the selected structure, right-click on [Tree (Structure)]
panel and select [Fit View to Element size] or [Display Surroundings Only] from the context

menu.

Tree

Cverview  Fipe

Plane

Structure Dot

=-;A=) Structure
= Structural Group: 0

0] Square Pipe: 1
- q P
uare Pipe:
- =

Fit View to Element size

Display Surroundings Only

Delete

SEEERT

Move

Rename

* Right-click on an element on [Tree (Structure)] panel, and select [Collapse All Structural
Groups] from the context menu to close the entire structural groups.

Tree x|
Overview  Pipe  Plane  Structure  Duct
B scure -

N
....1

Collapse All Struct

Square Pipe: 5
—--[ﬂ Structural Group: 1

T I-beam:0
..[/OC H-beam: 6
[ H-beam:7
..[/TIC H-250x250: 8
- Structural Group: 2
¢ LIZHAC H-125x125:9

=ML Group Structural Groups

.| ¥ Highlight Group Names in Display Ce

ural Groups

>

2 ELYSIUM © 2023 Elysium

Tree

Cverview  Pipe  Plane

Structure

+[§ Structural Group :
+Eﬂ Structural Group :
5 Structural Group:
+[‘Q Structural Group :
W [‘Q Structural Group :
+ [ﬂ Structural Group :
5 Structural Group:
+Gj Structural Group :
[ Structural Group:
+[‘Q Structural Group :

=T == R = Y O L -, == |

Page 103 | 145



Elysium InfiPoints Operation Manual Vol.3. Point Cloud Utilization - Modeling -

* Select a structural element in either [Tree (Structure)] panel or 3D View Window. The
element information such as length and standard type will be displayed in [Property] panel.

#2 ELYSIUM © 2023 Elysium

Froperty

[ Coordinate svstem (World coordinate system) ]
H-beam [0]

Start point: (00464 m, —6.0489 m, 1004293 m)
End point: (32689 m, ~06GEG m, 1004307 m)
Length: 652732 m

Section drea: 639000 cm?

Wolume: 00432 m3

Waight: 3302055 kg

fxiz Position: Middle Center

Standards: -

Height(H}: 250.0000 mm
Width(BY: 1265.0000 mm

Wieb thickness(t1) 20,0000 mm
Flange thicknesz{t2): 9.0000 mm
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3.6.2. Separating Structures to Another Group

1. Right-click a structural part "Structure" at the top of [Tree (Structure)] panel, and select
[Group Structural Groups] from the context menu. A group folder is created.

Plane Structure Duct

Oveniew Pipe

=-M3
w7

¥ Highlight Group Names in Display Color

Collapse All Structural Groups

1

Overview Pipe Plane Structure Duct

'Ph'i" C1 d
410 Grouped Structural Group

2. Right-click on the group folder you have just created and select [Rename] from the context
menu. The folder name will become editable, so enter the folder name.

Plane Structure puct

Qverview Pipe
E-IE) Structure
E Structural Group: 0

Fit View to Element size
Display Surroundings Only

Delete

Move

Group Structural Groups

>

Overview Pipe Plane Structure Duct

E-IE) Structure
e

oup01

- Please note that if you want to return the folder name to default, erase

i

the folder name with [Backspace] key, etc.

o The [F2] key can be used to rename.

3. With the structural element selected, right-click and select [Move] from the context menu.
Then select the created structure group folder. The selected structural element will move to

the specified group folder.

Plane Structure Duyct

: 0
Structural Group01: 1

Overview Pipe Plane Structure Duyct Overview Pipe
=5 Structure A =153 Structure
- Structural Group : 0 v [0 Structural Group
= Fit View to Element size = 0
N : )
Dis| Surroundings Onl

W = play gs Only
@: I Dalats
b= Rename
Y| or |
JeAml ¢

¥ ELYSIUM © 2023 Elysium

Page 105 | 145



Elysium InfiPoints Operation Manual Vol.3. Point Cloud Utilization - Modeling -

Please note that you can also drag-and-drop the selected structural element
to the target group folder to move it.

Overview Pipe Plane Structure Duct Owverview Pipe Plane Structure Duct
AL L-200x90x9x14: 23 ~ L, L-200x90x%x14: 23 ~
-l L-200490x9x 14 : 24 i eIl L-200090x9x14: 24
0] RP-250x150x6: 25 | |.IZI0] RP-250x150x6: 25
T CT-62.5%125: 26 M CT-62.5x125: 26

FAL, L-150x90x9 : 27 §LBL, L-150x90x9: 27
L, L-25090x10x15 : 28 > L L-250x00x10x15: 28
;29 = ]33 Structural GroupDd1: 1
I H-230x125:3
ML, L-200x00x9x14: 20
[P F40xT5: 30
-../FC H-200%150: 31

o M= F-45:280: 32 @

4. With the structural element selected, right-click and select [Move] > [New Structural Group]

from the context menu.

Overview Pipe Plane Structure Duct

9--@@ Structure ~
5@[@ Structural Group : 0
= Fit View to Element size
= Display Surroundings Only
= Delete
— F ~  Highlight Group Names in Display Color Structural Group01

-ML L Collapse All Structural Groups
@E SE

= — Properties

5. "Create a Structural Group" dialog will appear. Enter the structure group name and click

[OKI.

Create a Structural Group >

Structural Group Name: | Structural Group02|

[ ok || cance |

The selected structural elements will move to the created group folder.

Overview Pipe Plane Structure puct

E'L_r' CT-62.5x125: 26 ~
AL, L-150x90x9: 27

L L-250x00x10x15: 28

Structural Grou
|5 Structural Group02: 2
= F-40x230:0
A= F-Ex150: 1
= F-45x¢180: 2
= F-25x50: 4
= F-36x150: 5 .

¥ ELYSIUM © 2023 Elysium
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3.6.3. Changing Show/Hide Status of Structural Elements

* Check on/off the check box next to the structure group in [Tree (Structure)] panel to

show/hide elements that belong to it.

Overview Pipe Plane Stucture Duct

Overview Pipe Plane Stucture Duct

5 &

|5 Structural Group: 0
= F-d5xd00: b
M= F-45%x300:7
M= F-4.5x44:8
L, L-250x250%25: 9
210 SP-100x100x2.2: 10

-5 Structure A
E| [ 15 Structural Group: 0
| = F-45:400: 6
= F-45%300:7
= F-4.5x44:8
D]:I L-2500250025: 9
| |0] SP-100700x2.3: 10

* Check on/off the check box next to the "Structure" in [Tree (Overview)] panel or [Tree
(Structure)] panel to show/hide all structural elements.

Ovenview  Pipe

Plane Structure Duct

Plane Structure Duct

Oveniew Pipe

=2-ME Medel
E@D Scans
B0 Groupt

3.6.4. Editing Structural Color

== Structure

B Structural Group: 0
= F-d45%400: 6
M= F-45x300:7
M= F-4.5x44:8

L, L-250x250025: 9

1. Right-click structure group and select [Edit Display Color].

Owerviem  Pipe

Plane Structure  Duct

E--EE Structure

E@@ Structural Group: 0

ighlight Group Names in Display Color

Fit View to Element size

Display Surroundings Only

Delete
Move »

Rename

Properties

1

2. "Color" dialog will appear. Specify any color you prefer and click [OK].

¥ ELYSIUM © 2023 Elysium
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s

Color

Basic colors:

ol ol W ol o
_ Wl Rl B 0
A0 RN R
BN U BN BN B .
"2 R R B RER
"B R RN el A

Custom colors:

[ r
[ r

i
171
171
171
171

Cefine Custom Colors =

Gancel

Selected color will be reflected.

Q Right-click structure group and select [Reset to Default Color] to reset the
display color to the default.

Tree x|
Overview Pipe  Plane  Structure  Dyct

=5 Structure
=M= ral Group

Fit View to Element size

Display Surroundings Only

Delete
Mowve ¥

Rename

Edit Display Color...
Reset to Default Color

~  Highlight Groeup Names in Display Color

< Properties
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4. Duct Modeling

This section explains how to manually create, delete, and edit ducts that are automatically
extracted by the function [Extract Planes and Pipes].

Preparing for Duct Modeling

« If planes are not yet extracted, run [Extract Planes and Pipes] first. Refer to "Extracting
Planes Refer to "Extracting Planes and Pipes" in "InfiPoints Operation Manual Vol.1
Data Pre-processing” for details.

[# 3 |Z|SmartFilter ~|  SinfiPoints
Home ImportI Pre-process I Analysis Modeling Cutput Creation Recent Help

Sy .11 Define the origin ~ | %, Create Reference Point = | 4.~ | -':'_:_1:;‘., L 3"\ A
= Move Point Cloud —t — == —
Start R . Remove Extra Extract Planes
Registration [ [+ Fitto CAD / Polygon Model Fal Noiser | Text and Pipes
Register Reference Point Filter Extract Primitive

* If ducts are not displayed in the 3D view window, select [Home] tab > [Display Status]
> [Show/Hide Duct Elements] ( (=~ ). Similarly, select [Show/Hide Plane] if planes are

not displayed.

|Z|SmartFiIter * | FinfiPoints

Import Pre-process Analysis Modeling Output Creat

et feor e — -

G el I I o [ I O I E
View Operation Display Status
0 Click on the [Show/Hide Duct Elements] to change from [Show Duct
Elements] ( (- ) to [Hide Duct Elements] ( (- ).

 Select [Modeling] tab > [Duct] from the Ribbon menu.

| £ * |Smart Filter - ;'?InfiPoints
Home Import Pre-process Analysis I Maodeling I

Piping Structure Flane Duct

The [Duct] tab appears. Users can create duct models using these functions.

[ 2 o X g !5,—,—,3”: Filter = | FInfiPoints Modeling Tool
Home Impaort Pre-process Analysis Madeling Output Creation Recent Help Duct |
= 7 /| = T —]
30 J 55 |
@ #G @ R & @ S 7 R X
Extract Planes Create Connect Add Edit Duct Edit Duct Divide Reduce Section Move Copy Merge Duct Duct In
and Pipes Straight Duct  Ducts Duct Section Length Straight Duct Size by Offset = = Coaxial Ducts = Elements Groups S
-

Extract Primitive Create Edit Delete
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4.1. Creating New Straight Ducts

1. Select [Duct] tab > [Create Straight Duct] ( (= ).

|n 3 %% Smart Filter = %InfiPoints Modeling Tool
Home Import Pre-process Analysis Modeling Cutput Creation Recent Help I Duct
°a [ ] ; TS (g
Y | & gm Az & o oF =36
Extract Planes Create Connect Add Edit Duct Edit Duct Divide Reduce Section Move Copy Merge Duct
and Pipes Straight Ductf Ducts Duct Section Length Straight Duct Size by Offset = = Coaxial Ducts | Elements
Extract Primitive Create Edit Del

2. Select planes to create straight duct from, in "3D View" window, and click [Done] ( 0 ).

Planes used to create ducts can either be saved or deleted by choosing Keep
or Delete for [Whether to keep original planes] on the [Option] panel.

Option x|
¢.¢' Options

Whether to keep original planes
{® Keep
()Delete

Section height when spedfying one side anly

LI

3. The following dialog will appear. In this example, click [No].

*

Would you like to modify the section size and location of the straight
duct to create?

(You can also modify later with [Duct] tab = [Edit Duct Section] /
[Reduce Section Size by Offset].)
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By clicking [Yes], the "3D View" window will switch to the Section mode and
you will be able to edit the section of a straight duct. For details refer to
4.2.2, “Editing Straight Duct Sections” for operation procedures.

A straight duct is created.

"Duct System" is added to the [Tree (Overview)] panel.

Tree x|
Overview  Pipe  Plane  Structure  Duct

=- 5 Model
|_——_|.[:| Scans

-3 Groupt
-[Jeik 20150217A-1

-[£# 20150217A-2

- 48 20150217A-3
-[Jek 20150217A-4
-[1£¥ 20150217A-6

- 48 20150217A-7
..-"__.-" Extracted Planes

-p/| [ Extracted Piping System
blE) Duct System

4. Click [Cancel the selection and quit this function] ( Q ), or press [Esc] key to finish creating
straight ducts.
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4.2. Adjusting the Size and Position of Ducts

4.2.1. Editing Straight Duct Length

1. Select [Duct] tab > [Edit Duct Length] ( &)

) Smart Filter ~  FInfiPoints Maodeling Tool
Home Import Pre-process Analysis Maodeling Cutput Creation Recent Help Duct
Ty = - =l =R E N ) S5y F|| R =%
@ 6 HIRG & S F] KK
Extract Planes Create Connect  Add Edit DuctiEdit Duct Divide Reduce Section Move Copy Merge Duct Duct
and Pipes Straight Duct  Ducts Duct Section | Length |[Straight Duct Size by Offset - - Coaxial Ducts | Elements Groups
Extract Primitive Create Edit Delete

2. Select a straight duct to edit the length in "3D View" window. Handles will appear at both
ends of the selected straight duct.

3. Drag the handle on the side to shorten/extend.

The arrow on the handle indicates the side to move the endpoint of the
straight duct. Mouse-over a handle to switch the side for edit.

#2 ELYSIUM © 2023 Elysium Page 112 | 145



Elysium InfiPoints Operation Manual Vol.3. Point Cloud Utilization - Modeling -

o Specify the actual length at "Length" field in [Option] panel, and the
selected straight duct will be shortened/extended from the side with an

arrow.
Option x|
'a'¢_ Options
@ [OMove elements on red side asis

Length 0.876102 | m

Move elements on green side as is

|7 Edi by Click |

o Click [Edit by Click] in [Option] panel, and specify the endpoint in "3D
View" window. The selected straight duct will be shortened/extended
Q from the side with an arrow to the clicked location.

Option
Options
na_ P
® [IMove elements on red side as is

Length 0.876102 | m

Move elements on green side as is

|7 Edit by Click

4. Click [Done] ( @ ) to finish editing the currently-selected straight duct.
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5. Click [Cancel the selection and quit this function] ( O ) or press [Esc] key to exit the
command.

4.2.2. Editing Straight Duct Sections

This section explains the procedure to optimize the size of the existing duct elements by editing
the section of existing straight duct elements.

1. Select [Duct] tab > [Edit Duct Section] ( |-}, ).

= | Smart Filter ~ | FInfiPoints Modeling Toal
Home Impaort Pre-process Analysis Maodeling Cutput Creation Recent Help Duct
Al 7 a0 M N1 S “t] BT [ o ( 7
— (A ' Uz || &3 ¢ e T S - X
Extract Planes Create Connect Add Edit DuctfEdit Duct Divide Reduce Section Mowve Copy Merge Duct
and Pipes Straight Duct Ducts Duct Section || Length Straight Duct Size by Offset = = Coaxial Ducts = Elements
Extract Primitive Create Edit Dele

2. Select a straight duct to edit in "3D View" window. Handles will appear.

Icons to switch 3D View and 2D View will appear in "3D View" window.
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4. Edit the value of "Thickness" field in [Section] panel to decrease/increase the thickness of the

section.
BE x| BrE |
8[| v ] 4% e 5 8%~ 4] & OB
Hide points outside section [] Section Mode Hide points outside section [ Section Mode
[ Display the section Use Curve [ Display the section Use Curve
Highlight points Auto-align to Z-axis Highlight points Auto-align to Z-axis
Display area Display area
OPlus side O Minus side | ® with thickness OPlusside O Minus side | ® With thickness
Thickness | 0.1 = Thickness ||| 0.35832 =2

Elements (point cloud, planes, etc.) within this distance from the section will be shown in 2D

View.

Please refer to [Close Look into a Certain Region Only] > [Using Section
Q View] > [Display Area of Section] in Elysium InfiPoints Operation Manual
Vol.2. Point Cloud Utilization - Simulation & Data Utilization for the details

about the display range of the section.

5. Drag the handles to resize the straight duct section.
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Check "Set the snap length of handles" option in [Option] panel, and the
handles will move snapping at the specified intervals.

Option
Q 'n"n_ Options

Length of one step

ITI

6. Click [3D View] at the top right corner of "3D View" window to switch to 3D View.

Show/Hide the surrounding elements (point cloud, planes, etc.) as required in [Home] tab to
confirm that the straight duct size is appropriate.

7. Click [Done] ( 0 ) to finish editing the currently-selected straight duct.

8. Click [Cancel the selection and quit this function] ( @ ) or press [Esc] key to exit the
command.
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4.2.3. Adjusting the Duct Position

This section explains the procedure to optimize the placement of the existing duct elements by
editing the location/orientation of the duct elements referencing the point cloud, etc.

® Move Duct Groups

1. Select [Duct] tab > [Move] > [Move Duct Group] (:_’ ).

[ o o |Smart Filter ~ FInfiPoints Modeling Tool
Home Import Pre-process Analysis Madeling Cutput Creation Recent Help I[ Duct |
SH ] | At % g |
5 £ 5 ® @& &Sl #1 &

Extract Planes Create Connect Add Edit Duct Edit Duct Divide Reduce Sectiony| Move || Copy Merge Duct
and Pipes Straight Duct  Ducts Duct Section Length Straight Duct Size by Offset = = Coaxial Ducts  Elements

Extract Primitive Create Edit 25 Move Duct Group Dele

Tree R x | 25 Move All Duct Groups

[Move] panel will also appear.

Parallel move Rotation move

® Reltive (O Absolute | World coordinate system
Translate distance X | a ‘m Y | 0 |m z | a |m 2| (m)
pitch 0l 2 (m)

Orientation: (@) Rotation axis O X¥(Top) O YZ(Right) O XZ(Front) ' Section
Shap Angle;

Mo Snap w Mowve Restore

3. Drag the yellow handle in "3D View" window.
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The selected duct group(s) will move aligning to the selected orientation.
(Left: Before / Right: After)

Please refer to [Move] in Elysium InfiPoints Operation Manual Vol.2. Point
0 Cloud Utilization - Simulation & Data Utilization for the operation in [Move]
panel.
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4.3. Connecting and Adding Duct Elements

4.3.1. Connecting Duct Elements

The following explains how to connect newly created straight ducts. In this example, we will
show you how to connect straight ducts using a duct elbow.

1. Select [Duct] tab > [Connect Ducts] ( £).

|n % % % |Smart Filter @ ?InfiPoints Modeling Tool
Home Import Pre-process Analysis Modeling Output Creation Recent Help I[ Duct II
° | - — | |
] - TS :
s, @6‘3%@@* ) =S4 7| R %
d

Extract Planes Create Connect Edit Duct Edit Duct Divide Reduce Section Move Copy Merge Duct Duct
and Pipes Straight Duct Ducts | Duct Section Length Straight Duct Size by Offset k4 k4 Coaxial Ducts | Elements Groups

Extract Primitive Create | Edit | Delete |

2. Select "Duct Elbow" in [Option] panel.

'n.‘ﬁ' Options

O Hopper

O S-curve

3. Pick two straight ducts to connect on "3D View" window.

A duct elbow is created to form a single duct group.
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4.3.2. Adding Duct Elements

The following explains how to add additional duct elements to newly created duct elements

1. Select [Duct] tab > [Add Duct] ( ﬂ; ).

A Smart Filter - FInfiPoints Modeling Tool
Home Import Pre-process

Analysis Maodeling OQutput Creation Recent Help Duct
) ) A | A - 3;’( = é_ TT [ R
—_ A G- |07 | (—w’ M) e 85 & X X
Extract Planes Create Connectf Add dit Duct Edit Duct Divide Reduce Section Move Copy Merge Duct Duct
and Pipes Straight Duct  Ducts Duct Section Length Straight Duct Size by Offset - - Coaxial Ducts | Elements Groups
Extract Primitive Create

Edit Delete

2. Select a duct element to add a duct element to. The result preview will be shown in "3D
View" window as you move the mouse cursor.

o Connecting parts cannot be attached in sequence.
0 - If a connecting part is selected, only straight ducts can be created.

o Only Straight ducts and duct elbows can be created using this function.
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Change the orientation to create duct elements at "Orientation of layout" in
[Option] panel as required. Specify other options if necessary.

Option x|

ﬂﬂ Options

Crientation of layout

® A (]
Q Snap to world coordinate X/ /2
Angle degree(s)
Snap Angle:
Every 90 degrees w

Duct elbow type
() short radius (® Long radius

Rounded throat f Rounded heel

(e.g.,) If [B] is chosen in [Orientation of layout]

3. Move the mouse simulating the result with the preview, and left-click to create the
previewed duct element(s).

0 Upon the creation with a left-click, you can continue adding new ones to
the last-created duct element.

4. Click [Cancel the selection and quit this function] ( O ) or press [Esc] key to exit the
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command.

4.3.3. Merge Coaxial Ducts

The following explains how to connect straight coaxial ducts.

1. Select [Duct] tab > [Merge Coaxial Ducts] ( &* ).

@ A Smart Filter - FInfiPoints Modeling Tool
| Home Import Pre-process Analysis Maodeling OQutput Creation Recent Help Duct
Py arl P ¢ t . z7 = _/‘_ 2 E : P ==
B | & G B ® & g =S| ¢ X X
Extract Planes Create Connect  Add Edit Duct Edit Duct Divide Reduce Section Move Copy Merge Duct Duct
and Pipes Straight Duct  Ducts Duct Section Length Straight Duct Size by Offset - - Coaxial Ducts| Elements Groups
Extract Primitive Create Edit Delete

2. Pick two or more straight ducts to merge on "3D View" window and press [Done] ( @ ).

The selected straight ducts will be merged into a single duct.
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9 Only straight ducts that have comparable axis and are similar in size and
orientation can be merged.
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4.4. Editing Duct Elements

4.4.1. Dividing Straight Ducts

1. Select [Duct] tab > [Divide Straight Duct] (¢ ;-* ).

-‘ ) Smart Filter = FInfiPoints Modeling Tool
F Home Import Pre-process Analysis Modeling Qutput Creation Recent Help Duct
oy Al A x Vo = ot TE h /7 03
— 171 Oz | =238 X ¥ len -y & iz X X
Extract Planes Create Connect  Add Edit Duct Edit Duct] Divide R?auce Section Move Copy Merge Duct Duct
and Pipes Straight Duct Ducts Duct Section Length [5traight Duct | Size by Offset ~ = Coaxial Ducts | Elements Groups
Extract Primitive Create Edit

Delete

2. Select the straight duct you would like to divide.

The selected straight duct will be divided.

4.4.2. Deleting Duct Elements

1. Select [Duct] tab > [Duct Elements] ( [%¢ ).

Modeling Tool

Recent Help Duct

= yav /A IF= \ 4 % Replace All
Eall ¥ e B & (e \ ,
L4 LtV - = “; - x X o Settings on 5t
Divide Reduce Section Copy Merge Duct Duct Individual
jight Duct Size by Offset Coaxial Ducts [ Elements fsroups | Selection
Edit Delete Standard Parts

2. Select the duct element you would like to delete.

#2 ELYSIUM © 2023 Elysium Page 124 | 145



Elysium InfiPoints Operation Manual Vol.3. Point Cloud Utilization - Modeling -

The selected duct element will be deleted.

4.4.3. Deleting Duct Groups

1. Select [Duct] tab > [Duct Groups] ( "§¢ ).

Modeling Tool

Creation Recent Help Duct

| B E /A jr= v %g Replace All

e 2 (Fauls . ¢

[Ca i = . _§ x 29 b Settings on Standar
duce Section Move Copy Merge Du Duct Individual
ze by Offset E = Coaxial Ducts = Elements) Groups| Selection

Edit Delete Standard Parts

2. Select the duct group you would like to delete from the 3D View Window.

The selected duct group will be deleted.
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4.4.4. Offsetting Duct Groups

The following explains how to offset duct elements. This can be useful, for example, when you
would like to resize the duct inward to remove the thickness of a heat insulating material.

1. Select [Duct] tab > [Reduce Section Size by Offset] ( }:;_. ).

= | Smart Filter = FInfiPoints Modeling Tool
Home Impaort Pre-process Analysis Maodeling Cutput Creation Recent Help Duct
, [ — g o) rt ZA i | — ( v
o] [ ] ] [A k- [ ] | =y L ¥
s % Oz | &3 X B bie, rat, > 4

Extract Planes Create Connect Add Edit Duct Edit Duct Divide Reduce Section Copy Merge Duct

Mave
and Pipes Straight Duct Duds Duct Section Length Straight Duct) Size by Offset v = Coaxial Ducts | Elements
Extract Primitive Create Edit Dele

2. On "3D View" window, pick the duct group to offset and press [Done] ( Q ).

T

Use [Smart Filter] to limit your selection.

- |Piping Element / PI|= #InfiPoints -

0 Impor _Smart Filter lut;
— Fiping Element / Plane / Duct Element
'/:', Piping Group / Plane Group / Duct Group

Create onne it Du it Du wide
Straight Duct Ducts Duct Length Section Straight Duct
Create

3. "Reduce Section Size by Offset" dialog will appear. Set the offset value to "0.1 m", and click
[OK]I.
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Reduce Section Size by Offset X

Offset by

48\ JAN ALY A\

4. Click [Cancel the selection and quit this function] ( @ ) or press [Esc] key to exit the
command.

1
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4.5. Copying and Moving Duct

4.5.1. Copying Duct Elements

The following explains how to copy duct elements or duct groups. This can be useful, for

example, when you would like to create new duct elements or duct groups by copying and
rotating existing components.

m Copy Duct Groups

1. Select [Duct] > [Copy] > [Copy Duct Group] ( “ ).

e j| < Smart Filter »  FInfiPoints Modeling Tool
Home Import Pre-process Analysis Maodeling Cutput Creation Recent Helpl Duct I

23 | a A0 | &1 &) i ~— =l T ( = SeE|
1 | £ | Aln | G5 A
W g G EH R T 5 35|92 X X ¥ g
Extract Planes Create Connect Add Edit Duct Edit Duct Divide Reduce Section Movel| Copy Merge Duct Duct Individual
and Pipes Straight Duct Ducs Duct Section Length Straight Duct Size by Offset = > oaxial Ducts Elements Groups = Selection

Extract Primitive Create Edit Copy Duct Element 5

Tree L | Copy Duct Group I
Overview  Pipe  Plane Structure Duct Copy All Duct Groups to Another Duct System

2. Select a duct group to copy in "3D View" window, and click [Done] ( 0 ).
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o Default setting of [Smart Filter] is "Duct Element". To select a duct
group, switch to "Duct Group".

=] . .
~ |Piping Element / PI|™ #InfiPoints -

Impor _Smart Filter lutl

~— Piping Element / Plane / Duct Element
[/.', d Piping Group / Plane Group / Duct Group
Create anne it Du it Du vide

Straight Duct Duds Duct Length Section Straight Duct
Create

- Please note that the axis of the displayed guide corresponds to the XYZ
direction in the current coordinate system.

3. Move the mouse cursor along the guide and left-click at any position to confirm.

You can also specify the moving distance of the copied duct numerically in
[Option] panel.

Option % |

Q ‘u'u Option

Distance

4. Press [Done] ( Q ) to copy the duct continuously. Click [Cancel the selection and quit this
function] ( Q ) or press [Esc] key to exit the command.
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4.6. Replacing Ducts with Standard Parts

The following explains how to replace duct elements with registered standard parts.

4.6.1. Setting for Standard Parts

The standard parts setting is optional. Some standard parts are already pre-registered in
InfiPoints.

1. Select [Duct] tab > [Settings on Standard Parts] ( ngi ).

Maodeling Tool

=3 Replace All | = =

g i B % |G
& BN ’; Settings on Standard Partsl it iy

Duct Duct Individua Align Duct  Align All Clase

Elements Groups = Selection Group  Dud Groups  this Tab
Delete Standard Parts Align Exit

"Setting on Duct Standard" dialog will appear.

Settings on Standard Parts >
Settings on Duct Modeling File of Standard Parts:
Valid Filename Path name
ModelLibrary_Master.ini C:\ElysiumInfiPoints\InfiPoints\config
< >
Add Edit Delete
Cancel Apply

o Use the [Add] button to add standard parts files.
o Use the [Edit] button to edit standard parts files.
o Use the [Delete] button to delete standard parts files.

2. Check the checkbox to choose the standard parts file to use.

4.6.2. Replacing Duct Elements Separately

The following explains how to replace a single duct element, or all of the duct elements in a
duct group at once.

1. Select [Duct] tab > [Individual Selection] ( Ew ).
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Maodeling Tool
Help
A %, Replace All = 7]
! x 4 ) | m
w5 Settings on Standard Parts
Duct Duct Individual Align Duct  Align All Close
Elements Groups § Selection Group  Duct Groups | this Tab
Delete Standard Parts Align Exit

2. Select the duct element in the 3D View Window.

2 ¥2FIAE [

3. "Replace with Standard Parts Manually One by One" dialog will appear. Select a new duct
standard.

Replace with Standard Parts Manually One by One X

Duct Elbow Standards LONG, 90, 600x 1000 ~

[} show All Standards

Replace all duct elements in same path

Cancel

Enable [Replace all duct elements in same path] to replace all duct
elements that are traceable through straight ducts, duct elbows, and S-

0 curve with the identical section dimensions of the selected standard.
However, if a hopper is included, the standard replacement ends at that
point as the section size changes.

4. Click [OK] to replace the duct element with a standard part.
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Change the display to [Highlight Standard Parts] so that you can easily
identify ducts that were replaced with standard parts. Duct elements not
replaced with standard parts will be displayed in white.

Q Output Creation Recent Help

- o8 7| 13 - 1

Default Color

,‘-' . Classify by Duct Group

15
+@# Highlight Standard Parts
|1 Show Axes of Duct Elements

4.6.3. Replacing All Duct Elements

1. Select [Duct] tab > [Replace All] ( E‘w ).

Maodeling Tool

Help Duct

27 = Zp Replace All Ll T=a

( \ % ||

y x x w s Settings on Standard Parts m

Duct Duct Individual Align Duct  Align All Close
Elements Groups = Selection Group  Dud Groups  this Tab

Delete Standard Parts Align Exit

2. "Replace All Elements with Standard Parts" dialog will appear. Set the tolerances for section
size and angles.

Replace All Elernents with Standard Parts X

Tolerance for section size mm
Tolerance for angles degres
Concel

3. Click [OK] to replace all duct elements with standard parts.
(Before: Default View) — (After: Highlight Standard Parts)
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Change the display to [Highlight Standard Parts] so that you can easily
identify ducts that were replaced with standard parts. Duct elements not
replaced with standard parts will be displayed in white.

Q Output Creation Recent Help

- 22 - ap 13 - 1 -

Default Color

,,' . Classify by Duct Group

15
+@# Highlight Standard Parts
|1 Show Axes of Duct Elements
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4.7. Aligning Duct Elements

4.7.1. Aligning Duct Groups

The following explains how to align connected duct elements within the same duct group. For
example, if two straight ducts are connected with a duct elbow at an angle close to 45 degrees or
90 degrees, they will be aligned exactly at either 45 degrees or 90 degrees.

1. Select [Duct] tab > [Align Duct Group] ( 755 ).

Maodeling Tool
Help Duct
( 1 Cp w % Replace All Lol =a) -~
/ N, | e P m
x I @ : s Sinia _L> =t L
Duct Duct Individual Align Duct]  Align All Close
Elements Groups = Selection Group JDuc Groups  this Tab
Delete Standard Parts Align Exit

2. The following dialog will appear. Click [OK].

Confirmation >

Flease note that you cannot select duct groups that contain drouit{s).

[Joon't show this dialogue next time

3. Select a duct group to align, and click [Done] ( 0 ).

4. "Align Duct Group" dialog will appear. Set "Angle tolerance", enable "Also align horizontal
ducts to world coordinate X/Y-axes" if needed, and click [OK].
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Align Duct Group X

Angle tolerance

I:I degree(s)

Also align horizontal ducts to world coordinate XfY-axes

Cancel

The elements in the duct group will be aligned.

4.7.2. Aligning All Duct Groups

1. Select [Duct] tab > [Align All Duct Groups] ( 5 ).

Modeling Tool

Help

| L7 4 £y Replace All Ll T=a

| s f |
X s il g S 3
Duct Duct Individual Align Duct]  Align All Close
Elements Groups = Selection Group JDuct Groups this Tab

Delete Standard Parts Align Exit

2. "Align Duct Group" dialog will appear. Set "Angle tolerance", enable "Also align horizontal
ducts to world coordinate X/Y-axes" if needed, and click [OK].

Align Duct Group X

Angle tolerance

degree(s)

Also align horizontal ducts to world coordinate X fY-axes

Cancel
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All duct elements within the duct groups will be aligned.
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4.8. Editing Duct Tree

Use the [Tree (Duct)] panel to edit duct attributes. Duct geometry and position will not change.
For example, this could be useful in the following cases:

* When classifying duct groups for specific purposes such as "For Air Conditioning" and "For
Ventilation," and then when you would like to hide the "For Air Conditioning" ducts.

* When switching between hide/show for each group in order to export just the "For Air
Conditioning" ducts as CAD files.

4.8.1. Checking Ducts

* The duct structure tree appears when switching to the [Tree (Duct)] panel.

Tree H

Overviems  Pipe  Plane  Structure  Duct
=} Duct System

+- S Duct Group: 0

- AE Duct Group: 1

* The selected duct element in the tree is highlighted in the 3D View Window.

o When a duct system is selected on [Tree (Duct)] panel

Tree

Owverview Pipe  Plane  Structure  Duct
5-f1

+ J_ Duct Group : 0

s S Duct Group:1

a | | ! \
Conversely, if a duct element is selected in the 3D View Window, the corresponding duct
element in the tree will also be highlighted.
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o When a duct element is selected on "3D Vi

o Use [Pick Filter] to filter duct elements for easier selection.

ew" window

Tree

Qwerviem  Pipe Plane Structure  Duct

=-5) Duct System

: JAIE DuctGroup: 0
LA[] Straight Duct: 3
[\ Hopper:4

-7 Duct Elbow: 5
[ Straight Duct: 6

| \

Ltput

duce

Py T

=) " Piping Group!PIalE FInfiPoints -
Home Impof Smart Filter
oe Piping Element / Plane / Duct Element
— @ Piping Group / Plane Group / Duct Group
Extract Planes Crea iy — .
and Pipes Straight Duct Ducts Duct | % Divide Straight Duct

Extract Primitive

Create

« Merge C

Edit

- Hold down [Shift] or [Ctr]] keys to select multiple ducts.

* To check the surrounding point cloud of the selected duct element, right-click on the duct in
[Tree (Duct)] panel, and select [Fit View to Element size] or [Display Surroundings Only]

from the context menu.

Tree H
Owerview  Pipe  Plane  Structure  Duct

=S, Duct Group: 0 ﬁ
(] Straight Duct: 3
o .
A Fit View to Element size
M Display Surroundings Cnly
Hl
AP Delete
[] Rename
-HIF

Display Method of Duct Eleme

* Right-click on an element in [Tree (Duct)] panel, and select [Collapse All Duct Groups] from

the context menu to close the all duct group.
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Overview Pipe  Plane  Structure  Duct Overview Pipe  Plane  Structure  Duct
BE=E] o 5ystem »~ BEE] ot 5ystem

=R Group Duct Groups E@ Duct Group: 0

- Duct Group: 1
Display Method of Duct Elements >

[[] Straight Duct: 0 >

[P DuctElbow:5s
@D Straight Duct: &
@E‘ Duct Elbow : 7
ED Straight Duct: &
2-0E Duct Group: 1
“[A[] Straight Duct: 15

POATE Miart Flhasr 44

* Check the duct element or duct group properties in the [Property] panel.

(e.g.,) Selection of a duct group

[ Coordinate system (Morld coordinate swystem) 1 .
Piping Group [831]
Mumber of Elements: 39
Straight Pipe: 23
Flanee: &
Elbom: 7
Reducer: 2
Pipe Tee: 2
Mumber of Branches: 2
Loop: Does Mot Exist
Length: 93792 m

4.8.2. Grouping Duct Groups

1. Right-click on the duct part named [Duct System] in the [Tree (Duct)] panel and select
[Group Duct Groups] to create a group folder.

Overvienw  Pipe Plane Structure Duct

BSEE] 0ol
oS GEIR DG GRUR N |

@E DactGroup 2

2. Drag-and-drop duct groups within the group folder to move to a different group.

Overview Pipe  Plane  Structure  Duct

=-54 5 Duct Systemn
EIE Grouped Duct Group
m-E Duct Group: 1
2-Z"S Duct Group: 2
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You can also divide groups into subgroups within the same group.

Tree % |
Overview Pipe  Plane  Structure  Duct
Q =1 5] Duct System
EI[:| Grouped Duct Group

: |:| Grouped Duct Group

|:| Grouped Duct Group

[\ Duct Group: s

-1 Duct Group: 6

4.8.3. Renaming Duct Elements and Groups

» Right-click on the grouped duct group, duct group, or duct element in the [Tree (Duct)] panel
and select [Rename] or press the [F2] key to change the name.

Tree x|
Overview Pipe  Plane  Structure  Duct

=-54 =) Duct System
=13 Grouped Duct Group

SR [B) Grouped Duct Group
"‘5 Fit View to Element size
S Display Surrcundings Onl
- w3 Gr
S Duct( Delete
- Duct € WMove
Rename
Tree x|

Owerview Pipe  Plane  Structure  Duct

=i =) Duct System

E|[:| Grouped Duct Group

| EI[:| For Air Conditioneing
. m-bS DuctGroup: 2
[:| Grouped Duct Group

o Press [Export (CAD Model)] ( ﬁ ) to export CAD models corresponding
to the tree structure and name set here.

o It is recommended to use easy-to-understand names for groups such as
Q "For Air Conditioning."

- Renaming can be done by pressing the [F2] key while you select the
group, duct group, or duct element in the [Tree (Duct)] panel.

o Erase the name by pressing the [Backspace] key during edit to return to
the previous name.
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4.8.4. Changing the Show/Hide Status

* Check the box on the left side of the grouped duct group or duct group in the [Tree (Duct)]
panel to switch show/hide status of duct elements.

Tree H
Overvienw  Pipe Flane Structure Duct
=-bA & Duct System

|3|:| Grouped Duct Group
DE Duct Group: 1

ENME] Duct Group: 2
|:| [ Straight Duct: 0
[ Duct Elbow: 2

-0 [ Straight Duct: 3
m-bS Duct Group : 4

- When one of the duct elements is checked, the entire belonging duct

group will be changed to show status. It is impossible to change the
show status for each duct element.

Tree

Owerview  Pipe  Plane  Structure  Dust

=013 Grouped Duct Group

D@ Duct Group: 2
[J[] Straight Duct: 0

DEI" Duct Elbow : 2
L[] Straight Duct: 3

\S Duct Group: 4

o Check the checkbox of "Duct System" in the [Tree (Overview)] panel or
[Tree (Duct)] panel to switch the show/hide status of duct parts.

Tree x| Tree a
Owerview  Pipe  Plane  Structure  Duct Overview  Pipe
=5 Model

Plane Structure  Dust

BD Scans
A3 Groupt
A7 Extracted Planes

LAM Fxtracted Piping System
QT ]dP Duct System

i \S DuctGroup: 1
. =S Duct Group: 2
(] Straight Duct: 0

4.8.5. Changing Display Method

1. Change the display method of duct elements by selecting from the pull-down list of [Display
Method of Duct Elements] on the [Home] tab.

Maodeling Output Creation

Ev T v:|v:|v E| .

= ﬂﬁ? 2 “°| Default Color

Recent Help

-

* 'D_\'-.“ H'." = ] I -__I

..,, Classify by Duct Group
ay Status

24 Highlight Standard Parts

[11  Show Axes of Duct Elements
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o There are 4 display modes:

= [Default Color] ( )

= [Classify by Duct Group] ( gz )

 [Highlight Standard Parts] ( g g )
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= [Show Axes of Duct Elements] ( ] )

4.8.6. Changing Display Color of a Duct Group

1. Select [Classify by Duct Group] ( 5_:: - ) from the [Display Method of Duct Elements] pull-down
list on the [Home] tab.

t Filter ~|  FInfiPoints

Pre-process Analysis Modeling Cutput Creati

E - - a8 T - 8 T

Display Status

2. Right-click on the duct group of grouped duct group and select [Edit Display Color] in the
context menu to change the display color of the [Tree (Duct)] panel .

Tree H

Overview FPipe  Plane  Structure  Duct

=[] =0 Duct Systemn
=-[A[(3 Grouped Duct Group
-;- -- 1L [) oL
+ = |Ducl Fit View to Element size
"' \S, (Bt Display Surrcundings Only
+ Duct
Delete
Mowve
Rename
Edit Display Color...

3. "Color" dialog will appear. Specify any color you prefer and click [OK].
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[}
=3
o

-

...........

EEEEET
EEEN 1]
EEERNETT

Custom colors:

1"l FHENEN
'l HEEENF
11 "THEEER

| Define Custom Colors ==

| ok || Cancel |

4, The selected color will be reflected in the tree view.

Overvienw  Pipe Flane Structure Duct

=54 & Duct System
=-}123 Grouped Duct Group

G

Q To clear the selected color, right-click on the plane or plane group and

choose [Reset to Default Color] in the context menu.

Overview Pipe  Plane  Structure  Duct

=-54 =) Duct System
=13 Grouped Duct Group
@E Duct N

Fit View to Element size

Display Surroundings On

Delete
Mowve

Rename

Edit Display Color..
Reset to Default Color
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All rights reserved by Elysium or the original author of this material. The content may not
be edited, reproduced, distributed, transmitted, displayed, published, broadcast, sold or
lent without the prior permission of the author.
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